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THE OBLIGATORY LEGAL MUMBO-JUMBO

The Antares Infinity software and this User’s Manual are protected by
copyright law. Making copies, adaptations, or derivative works without the
prior written authorization of Antares Audio Technologies, is prohibited by
law and constitutes a punishable violation of the law.

Antares Audio Technologies retains all ownership rights to the Infinity
software and its documentation. Use of Infinity is limited by the following
license agreement.

Please carefully read all the terms and conditions of this license agreement.
At the time of installation of the Infinity software you will be presented
with a copy of the agreement and asked whether or not you agree to it.
Continuing with the installation process beyond that point constitutes such
agreement.

INFINITY LICENSE AGREEMENT

Antares Audio Technologies grants you a nontransferable, nonexclusive
license to use Infinity under the terms and conditions stated in this agree-
ment. Use of Infinity indicates your agreement to the following terms and
conditions.

You may:
1. Use Infinity on only one computer.
You may not:

1. Make copies of Infinity or of the user manual in whole or in part except
as expressly provided for in this agreement. Your right to copy Infinity
and the user manual is limited by copyright law. Making copies, verbal
or media translations, adaptations, derivative works, or telecommuni-
cation data transmission of Infinity without prior written authorization
of Antares, is prohibited by law and constitutes a punishable violation
of the law.

2. Make alteration or modifications to Infinity (or any copy) or disas-
semble or de-compile Infinity (or any copy), or attempt to discover the
source code of Infinity.

3. Sublicense, lease, lend, rent, or grant other rights in all or any portion
of Infinity (or any copy) to others.

TERM OF THE AGREEMENT

This agreement is effective until terminated by you or Antares. You may
terminate the agreement at any time by notifying Antares and destroying
all copies of the manual, and erasing Infinity from all machine-readable
media, whether on-line or on archival copies.



In the event of breach of any of the terms of this agreement, you shall pay
the attorney’s fees of Antares that are reasonably necessary to enforce the
agreement, plus resulting damages.

LIMITED WARRANTY AND DISCLAIMER

INFINITY AND ACCOMPANYING MATERIALS ARE PROVIDED “AS IS” WITH-
OUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE.

Antares Audio Technologies does not warrant that the functions contained
in the program will meet your requirements. The entire risk as to the use,
quality, and performance of Infinity is with you.

SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN
IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY
TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY
ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO
JURISDICTION.

LIMITATION OF LIABILITY

IN NO EVENT WILL ANTARES BE LIABLE FOR ANY DAMAGES, INCLUDING
LOSS OF DATA, LOST PROFITS OR OTHER SPECIAL, INCIDENTAL, CONSE-
QUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF Infinity OR
ACCOMPANYING MATERIALS. THIS LIMITATION WILL APPLY EVEN IF
ANTARES OR ITS AUTHORIZED AGENT HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE LICENSE FEE
REFLECTS THIS ALLOCATION OF RISK. SOME JURISDICTIONS DO NOT ALLOW
LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUEN-
TIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Whew! Now that that's over, let’s get on to the good stuff.
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Welcome!

e at Antares Audio Technologies offer both our thanks and congratulations
on your decision to purchase Infinity, the world’s best sample-looping
toolkit.

Before proceeding, please register and authorize your copy of Infinity.
(You can skip ahead a few pages to the Authorization and Installation
instructions. We'll wait.) Also, if you plan to discard that lovely Infinity
jewel case, write down the serial number that appears on the back for
future reference.

As a registered Infinity owner, you'll receive notification of any software
upgrades, technical support, and advance announcements of upcoming
products. But we can’t send you stuff unless we know who and where you
are. So please, register. Note that we do not share this information with
people who will pester you.

At Antares, we are committed to excellence in quality, customer service,
and technological innovation. With your purchase of Infinity, you have
created a relationship with Antares which we hope will be long and
gratifying. Let us know what you think. You can count on us to listen.

Again, thanks.
The Whole Antares Crew



Technical Support

n the unlikely event that you experience a problem using Infinity, try the
following:

—_

. Make another quick scan through this manual. Who knows? You may
have stumbled onto some feature that you didn’t notice the first time
through.

N

Check our web page for tips, techniques, or any late-breaking
information: http://www.antarestech.com

3. Call your local Antares dealer.

4. Email our tech support department by pointing your web browser to:
http://www.antarestech.com/support/etech.shtml and filling in the form
there.

5. Call us at (831) 461-7814 Monday through Friday between 10am and
5pm USA Pacific Standard Time (or leave a message any time and we'll
get back to you).

For options 3, 4, or 5, please be prepared to provide the Registration Code
of your copy of Infinity.

viii



Installation and Authorization

INSTALLING INFINITY

To install Infinity, simply copy the Infinity installer to your hard drive,
double-click the installer and follow the resulting directions. If you have
purchased Infinity as a download, decompress the downloaded file and
double-click the installer. In either case, be sure to read the Read Me file for
any late breaking news.

AUTHORIZING INFINITY

To run Infinity, the computer on which it runs needs to be authorized using
a “challenge/response” authorization technique. The first time you launch
this software, you will be presented with a string of words (the Challenge)
and will be asked to enter another string of words (the Response).

Note: When initially installed, this software will run for ten days
without authorization.

So even if you can’t authorize it right away, you can still use your software.
(During this period, click the “Try It” button whenever you are presented
with the Trial Period screen at launch.) But don’t procrastinate too long.
After those ten days are up, you can’t launch Infinity until you enter the
correct Response.

CHALLENGE/RESPONSE AUTHORIZATION

You can obtain a Response via the Antares web site, email, or fax. Web
authorization, an automated process, is available 24 hours a day. Email and
fax authorization involve the participation of actual live people and,
depending on when you send your challenge, may take from one to three
days to provide a response.

For web authorization, follow these directions:

¢ Launch Infinity. To access Challenge/Response authorization, press
“Next"” at the Trial Period screen to access the Challenge screen.



The Challenge screen displays the Challenge string. To receive the
appropriate Response you will need to provide us with both the
Challenge string and the registration code that was included on the
yellow card in your software package (if you bought a retail package)
or supplied with your download.

To obtain your Response, have your registration code and Challenge
string at hand. (If you will be accessing the web from the same com-
puter that will be running your software, you can press “Copy Chal-
lenge” at the Challenge screen and then simply paste the Challenge
into the appropriate field on the web page below.)

Point your web browser to:
https://transactions.antarestech.com/

and simply follow the directions. (Be extremely careful to enter the
registration code and Challenge string accurately.)

If, for some reason, you do not have access to the web but do have email,
copy and paste your Challenge string and registration code into an email
along with your name and the product name (e.g., Infinity for MAS), and
send it to:

register@antarestech.com

You will receive your Response string by return email.

If you do not have access to the web or email, fax your Challenge string
along with your registration code to us at (831) 461-7801. Be sure to
include your fax number. We will fax the Response string back to you at
that number.

Note: You may optimize (defragment) the hard disk containing the
Challenge/Response authorization, or even reinstall your system,
without losing the authorization. However, if you reformat the hard
drive or if it fails, contact Antares for the re-authorization procedure
(you are a registered user, right?).



Chapter 1: Getting Started

magine being able to take a raw sample, and then, with just a few mouse
clicks, create a loop so perfect that you can’t tell when it started or where
it repeats. Imagine doing that with sounds that are impossible to loop
smoothly using your current sample editor, like string orchestra, choirs, fat
analog synths, chorused guitar, and so on. Infinity lets you do that, quickly
and easily.

Infinity is a powerful DSP which uses unique DSP technologies to auto-
mate and improve the looping process (the part of sample editing that
takes the most time and skill).

Some of Infinity’s special features are:

REAL TIME LOOP ADJUST

Infinity makes fine tuning the loop easy by letting you move the loop
points anywhere in the sound file during real time playback.

SYNTHESIS LOOPER

The Synthesis Looper tool calculates the energy at each fundamental and
harmonic frequency and allows you to specify the width of the sidelobes
the resulting looped sound will have. In this way, you could take the
lumpy sound of a highly out-of-tune ensemble and change it to the
smoother sound of a higher quality ensemble, making the variations in
the loop repetition less noticeable.

SPR LOOPER

This tool automatically randomizes the spectral components of the sound
inside the loop points to create a virtually seamless result in sounds that
have irregular waveforms like string orchestra, chorus, analog synths,
cymbal rolls, and so on. Stereo samples retain their ambience and dimen-
sionality. The SPR Looper is protected by US patent law.

ROTATED SUMS LOOPER

This looping tool uses a convolutional approach to randomizing irregulari-
ties inside the loop points. Like the SPR Looper, it is excellent for use with
all sounds that have irregular (non-periodic) waveforms.



FREEZE LOOPER

The Freeze Looper creates perfect loops in sounds like winds, brass, bells,
and other sounds that have a pure harmonic series. It's also good for
“freezing” the timbre of decaying strings like piano or guitar.

CROSSFADE LOOPER WITH SMART AUTO-SCAN

This is an enhanced crossfade tool with an intelligent loop point scanner.
It uses a sophisticated DSP algorithm to find the right loop point automati-
cally.

FULLY ADJUSTABLE EDIT BLENDING

This editing feature allows the taper and length of the blend crossfades
used during edit operations to be adjusted to suit the sound you are
working on.

COMPLETE SAMPLE EDITING ENVIRONMENT

The Infinity environment provides all the basic tools necessary to create
professional quality samples easily and quickly.

Infinity is robust. It lets beginners get results which are superior to profes-
sionals using other programs. For professionals, Infinity provides a level of
quality, speed, and ease of use inapproachable by any other sample editor.

HOW TO USE THIS MANUAL

Infinity has a transparent user interface, has excellent Balloon Help and is
extraordinarily easy to use. However, the operation of the DSP Looping
Tools and some functions of the user interface will not be immediately
obvious because they do things which have never been done before. We
recommend that you read the following sections of the manual to take full
advantage of the quality and speed that Infinity makes possible.

¢ The Infinity Environment on page 7

¢ Viewing the Soundfile on page 16

¢ Editing the Soundfile on page 21

e Saving the Soundfile on page 34

e Customizing Your Environment on page 36

e Chapter 4: Infinity Looping Tools on page 39



THE CONTENTS OF THE MANUAL

Chapter 1: Getting Started

This chapter explains everything about starting Infinity and communicating
with Antares Audio Technologies.

Chapter 2: Introducing Infinity

This chapter explains the scope of Infinity’s functions and how it solves
current problems in the electronic music studio. Basic concepts in sample
editing and file management are also covered. The user interface is ex-
plained with emphasis on the anatomy of the Palette, and the Soundfile
Window.

Chapter 3: The Basics of Infinity

Infinity Basics explains how to perform all the basic functions in manipulat-
ing and editing a soundfile. The topics covered are: basic commands and
editing functions, changing the display resolution, viewing, listening to,
editing and saving the soundfile, and customizing the Infinity environment.

Chapter 4: Infinity Looping Tools

This chapter contains detailed instructions on how to use the looping tools.
We recommend this chapter as must-reading for everyone.

Appendix A: Keyboard Equivalent Commands

This appendix contains a list of all the keyboard equivalent commands and
shortcuts that can be used with Infinity.



Chapter 2: Introducing Infinity

amplers and sample players have become the most popular electronic
musical instruments because of the realism and fidelity made possible by
digital recording techniques. This realism comes at the price of ever increas-
ing memory requirements needed to produce the sustained tone of natural
instruments. Since samplers have finite memories, rudimentary looping
techniques have been used to create the illusion of sustained tones, but
often with less than satisfactory results.

THE PROBLEM WITH LOOPING

An ideal loop sounds like a uniform sustained tone. An imperfect loop is
detectable because one hears repetitive changes in the tone. Using stan-
dard looping techniques, it is possible to create an ideal loop only under
special conditions. These conditions are:

1. The waveform being played must be perfectly uniform during the
duration of the loop (which may be thousands of cycles long), and

2. The loop must start and end at the same point in the period of the
waveform.

This means that a perfect loop can only be created by using a sustained
periodic waveform. But this type of sound is only a small subset of the
sounds used in music making. Sustained sounds come in two varieties:

DIGIWAVE
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PERIODIC SOUNDS Sounds recorded monophonically which have stable
tone, loudness, and pitch. Examples are solo wind and brass instruments,
organ, and so on.

NON-PERIODIC
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NON-PERIODIC SOUNDS Some examples of non-periodic waveforms are
instrumental ensembles like string sections, brass sections, choirs, chorused
guitar and keyboard sounds and many waveforms from the older analog
synthesizers. Sounds that change tone as they decay like piano, harp,
timpani, bells, cymbal rolls, etc. are also non-periodic.



VIOLIN SECTION:
LEFT CHANNEL

VIOLIN SECTION:
RIGHT CHANNEL

Clearly, most of the sustained sounds that are used for music making are
non-periodic. It is impossible to make an ideal loop of a non-periodic
sound. The simple fact that the sound changes with time will cause the
repetitive nature of the loop to show up.

The problem becomes even more difficult when considering the stereo
case. If there are even slight changes to the shape of the two waveforms
then it becomes impossible to find loop points where the waveforms
precisely match. (A stereo loop cannot have a separate loop point for the
left and right channel because doing so would not preserve the stereo
relationship between the channels in the reproduced output.) The illustra-
tion below shows a segment of a stereo recording of a violin section
playing a single pitch. Note that the two waveforms don’t even resemble
each other.
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CROSSFADE LOOPS

One common compromise for looping non-periodic sounds is to blend the
sound leading up to the loop end point with sound around the loop start
point. This is called a crossfade. This tends to make the transition from loop
end to loop start less abrupt.

No technique will ever loop a non-periodic sound without leaving irregu-
larities somewhere in the loop. The problem with a crossfade loop is all of
the different frequencies in the sound make a transition from one phase to
another during the crossfade. This causes different combinations of con-
structive and destructive interference. Because this happens for all frequen-
cies at the same point in the loop, a noticeable bump is produced by the
crossfade loop.

The illustration below shows the process of creating a crossfade loop. The
waveform segment labeled “attack” is the part of the sound that is heard
before the loop begins. The line labeled “A" is the loop start point. The
line labeled “B" is the loop end point.

Used with skill and patience, crossfade looping techniques can result in
marginally usable loops in some non-periodic sounds. The level of quality
that results is currently considered acceptable, but is, in fact, mediocre
compared to what can be achieved by Infinity’s unique DSP tools.
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THE COSTS OF CURRENT METHODS

The time and effort required to make a good set of looped samples is more
than most musicians are willing to invest. With complex sounds like pianos,
string sections, chorused synths, and so on, it is extraordinarily difficult to
make good crossfade loops. Lumpy loops have necessarily become accept-
able.

The third party sound design business is booming. License to use pre-
looped sounds which are often of less than satisfactory quality costs
hundreds of dollars. While this saves time and effort, even the best com-
mercial samples have audible loops.

THE INFINITY ENVIRONMENT

Even experienced sound designers are advised to read this section carefully.
It contains basic information on the display and manipulation of digital
sound that is essential to using Infinity.

THE SOUNDFILE WINDOW
The soundfile window is a visual representation of the soundfile on the
desktop. Much of the work you do on the soundfile will be done inside the
soundfile window. The soundfile window has several components whose
functions are listed below.

TITLE BAR ZOOM BOX
CLOSE BOX »— |- - strings A% 4 - No Backup 2
OVERVIEW =

L o o oo
VIEW INDICATOR 7 T
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MAINVIEW o 1
PLAYBACK 50 1
POSITION POINTER =100
HORIZONTAL *—+— 1 25 0 50,000 75,00 100,000 iy
ANNOTATION ; IR
= |
GROW BOX

LOOP POINT

MIDI NOTE NUMBER



TITLE BAR

The Title Bar contains the name of the soundfile, the close box, the zoom
box, and either “No Backup” or “Backup Created” written next to the title
of the soundfile.

Infinity will create a backup file when the soundfile is first opened pro-
vided the corresponding Preferences dialog item is enabled. When “Backup
Created” is displayed in the title bar, the Revert to Backup command can be
used in the File Menu. See “Create Backup Files” on page 36.

CLOSE BOX
Clicking on the close box will close the soundfile window.

ZOOM BOX

Clicking on the zoom box will increase the size of the window to the
maximum allowed by the size of your video monitor. Clicking it again will
return the window to its original size.

OVERVIEW

The Overview displays the whole soundfile, the insertion point, loop points,
and the Playback Position Pointer. The Overview allows you to navigate
around the soundfile easily. In a stereo soundfile, the left track is displayed
above the right track.

Data can be chosen for display in the Mainview by using the view indicator
described below. Data can also be selected in the Overview by placing it in
the Selection Mode using the Palette. See “Using Selection Mode in the
Overview" on page 23 for details of how this is done.

VIEW INDICATOR

The view indicator is a dotted rectangular box which shows the borders of
the region of the soundfile which is currently displayed in the Mainview.
Any change in the Mainview is reflected by a change in the view indicator.
The region displayed in the Mainview can be changed by redrawing the
view indicator. The details are discussed in “Using Zoom Mode in the
Overview"” on page 17.

PLAYBACK POSITION POINTER

The Playback Position Pointer appears in both the Overview and the
Mainview. It is a non-blinking vertical line with terminals at each end that
moves across the screen as the soundfile plays. It shows where playback is
occurring so that you can correlate the sound and the graphic display of
the soundfile.



VERTICAL ANNOTATION

The Vertical Annotation allows you to measure the amplitude of the
waveform in the Mainview. The units displayed are either percent of full
scale or decimal sample values. The units for the Vertical Annotation are
chosen in the Preferences dialog. The Vertical Annotation and the soundfile
data can be moved up or down by using the vertical scroll bar when the
scale is expanded.

MAINVIEW

The Mainview always displays the part of the soundfile shown in the view
indicator in the Overview. When a file is opened, the Mainview initially
displays the whole soundfile. The amount of data displayed in the
Mainview can be changed by redrawing the view indicator in the Overview,
or by using the Display Scale Icon on the Palette. The Mainview can also be
placed in the Zoom Mode. See “Using Zoom Mode in the Mainview"” on
page 18. The data in the Mainview can be scrolled using several methods.
See "“Scrolling the Data File” on page 16.

TRACK DIVIDER AND ZERO CROSSING

The tracks in both the Overview and the Mainview can be separated by a
track divider line. There can also be a dotted zero crossing line in each
channel. These choices are made in the Preferences Dialog.

THE HORIZONTAL ANNOTATION

The Horizontal Annotation is located below the Mainview and runs the full
width of the window. It allows you to measure time in the soundfile. The
units for the Horizontal Annotation are selected in the Preferences dialog.
There are three display formats: Samples, Time, and SMPTE formats.

LOOP POINTS

The Loop Points show the region of data in the soundfile that will be
looped when the soundfile is played. The Loop Points can be moved by
dragging them horizontally. They can also be dragged during sound
playback.

Loop Points can be created by selecting the Create Loop Points menu item
in the Edit menu or by clicking on the Loop Points Icon on the Palette. The
Loop Points can be deleted by clicking on the Loop Points Icon or by
selecting the Delete Loop Points item in the Edit Menu.

GROW BOX
Dragging the grow box allows you to resize the window.



THE PALETTE

MODE ICONS

STATUS DISPLAY

The Palette is always present on the desktop. It contains information and
tools for editing the soundfile data. It is divided into three sections;

e Mode Icons
e Status Display
e Action Icons
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The area in the middle of the Palette is the Status Display. It is used for
verbal messages and as a cursor tracking display. The icons above the Status
Display are the Mode Icons. The icons below the Status Display are the
Action Icons. Icons which cannot be selected are grayed out.

The Palette can be dragged anywhere on the desktop by pressing on the

grey bar at the top of the Palette and dragging it to the desired location.
Pressing on the Palette in an area where there are no icons will reveal the
keyboard equivalent commands for the icons.

MODE ICONS

When Infinity starts, the Mainview is in Selection Mode and the Overview is
in Zoom Mode. The mode of a display determines what work can be done
on the data in that display. See “Using Zoom Mode in the Mainview” on
page 18 and “Using Selection Mode in the Overview"” on page 23 for
instructions on changing the mode of a display.

The mode icons are:

Selection Mode Icon: Selection Mode allows data to be selected in the
display. See “Specifying Where to Change Sound Data” on page 21.

Zoom Mode Icon: Zoom Mode allows specification of a region to be
displayed in the Mainview. See “Specifying Where to Change Sound Data”
on page 17.
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STATUS DISPLAY

The Status Display on the Palette gives information about the location of
the cursor. Four fields of information are displayed which show various
fields, depending on the current usage of the software:

Track: This field displays the track where the cursor is located.
C: This field displays the absolute time at the cursor location.
Amp: This field displays the vertical location of the cursor’s active pixel.

C-I: This field displays the horizontal position of the cursor relative to the
insertion point when the insertion point is present.

During a selection, this field reads “Select:” and shows how much data has
been selected.

When the loop points are being dragged and the cursor is in the Mainview,
this field reads “Loop:” and displays the amount of data inside the loop.

When the cursor is in the Soundview of the Crossfade Looper, this field
reads either “Side: Loop Start” or “Side: Loop End” depending on which
side the cursor is located.

THE ACTION ICONS
Speaker: The Speaker icon is used to play the soundfile. If a region is
selected, only that region will play.

Display Scale: The Display Scale icon is used to change the display resolu-
tion of the Mainview.

Fit Selection: The Fit Selection icon fills the Mainview completely with the
currently selected region.

Loop Points: The Loop Points icon creates or deletes loop points in a
soundfile.

Loop Start: The Loop Start icon scrolls the Mainview so that the Loop Start
point is in the center of the screen.

Loop End: The Loop End icon scrolls the Mainview so that the Loop End
point is in the center of the screen.



Information
Soundfile - strings A%4
File Type: dudia IFF
Tracks: 2
Duration: 133,92
Sample Rate: 44100
File Size: Sdek
Beqgin Loop : 83 316
End Loop : 108,300
Unused HD: 236, 718K

l! DK |l

GET INFO...

Keyboard Equivalent Command: 3-I. Selecting Get Info will cause the
Information dialog shown above to appear. It contains information on the
currently active soundfile. Data cannot be edited in the Information dialog.

Sound File refers to the title of the active soundfile.
File Type refers to the file format in which the soundfile is stored.

Tracks refers to the number of data channels that exist in the file: one track
for mono files, two tracks for stereo files.

Duration of the file is given in the current time format.
Sample Rate refers to the sample rate of the soundfile.
File Size of the soundfile is shown in kilobytes.

Unused HD states the amount of empty space that is currently available on
the hard disk of the currently active soundfile.

DISK BASED FILES

Unlike most Macintosh applications which store their open files in RAM,
Infinity uses disk based files. Changes made to the soundfile are automati-
cally written to the disk when the change is made. Soundfiles, however, are
played and processed from RAM. If a file is too large to fit in RAM, you can
select and play a smaller portion.



ENVELOPE FILES

In order to display a soundfile, Infinity creates an envelope file. These files
are stored in a folder called “Envelope Files” in the same folder as the
sound file. Envelope files are used to store information which allows
Infinity to quickly draw the soundfile on the screen. They occupy about one
tenth the disk space that the soundfile uses and are stored in a special
Envelope Folder which Infinity creates. Envelope files are saved in the
Envelope Folder after the soundfile is closed.

When data in the soundfile is shifted as a result of an edit, the envelope is
also shifted, hence avoiding more lengthy computations involving the
soundfile. Unfortunately, the envelope can only be shifted to an accuracy
of £10 samples. Hence, the envelope may be slightly inaccurate. In this
circumstance a “stale” flag is set in the envelope file.

Only the first envelope is shifted. The remaining envelops are recomputed
from the first envelope. This means the remaining envelopes will have
fewer errors. Specifically, each envelope frame (sample) will contain errors
of up to ten sound samples, however the second, third, fourth, etc. enve-
lopes represent 400, 8000, 160,000, etc. sound frames each. Thus, the worst
error will be 10 out of 400, 10 out of 8,000, 10 out of 160,000, etc.

The next time the soundfile is opened, the “stale” flag is checked, and if
the file is sufficiently large, the following message appears:

A\

The envelope file is older than the
soundfile, but the envelope file has the
correct number of samples.

[ Recompute ]

Choosing either command button will reset the “stale” flag and the
message will not reappear until the next edit.

When a soundfile is opened, if the envelope file is not found or if the
sample counts don’t agree with the envelope frame count, then the
envelope file is recomputed automatically. If the soundfile has been
modified by some other sample editing program, the envelope is consid-
ered to be “out of date”. If this “out of date” condition exists, and the file
is sufficiently large, the dialog shown above is posted. If “Recompute” is
chosen, the envelope is recomputed. If “Use Old"” is chosen, then the
envelope file is touched so the condition does not reoccur, and no prompt
will occur for the “stale” condition, even though the envelope file may be
stale.



BALLOON HELP IS
AVAILABLE FOR EVERY
ITEM IN INFINITY’S
USER INTERFACE.
SOME ITEMS HAVE
GRAPHICS TO EXPLAIN
COMPLEX PROCESSES.

BACKUP FILES

If the Create Backup Files function in the Preferences dialog is enabled, a
backup file is created when a soundfile is opened. Upon closing a soundfile,
the backup file is deleted. Note that other temporary files are created as a
result of edit operations involving the Clipboard and undo-able edits. These
are automatically managed by Infinity.

BALLOON HELP

Infinity incorporates on-line help using the Balloon Help feature. Choose
Show Balloons in the menu to turn on Balloon Help.
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Chapter 3: The Basics of Infinity

his chapter introduces you to the basic functions of Infinity. We recommend
«¥ | that you read it through once and then refer to it as needed while becom-
ing familiar with Infinity.

USING COMMANDS

USING KEYBOARD COMMAND EQUIVALENTS

The keyboard can be used to choose many commands. If a command has a
keyboard equivalent, it usually appears on the menu or on the Palette.

shift | cntr Undo #e
A opt. | shift Undo Loop Move
PUTINFINITY INTO || |occessssssesseeeseeeessesssssssssssssessesssssessssses s sessessssesssnes
SELECTION MODE Atow keys
soroll data, Cut 3+ H
<0pt.xLarrom
faor full zoom. EDDH #L
Paste #U
PRESSING THE SEacE +E€_+ #F Clear #B
SPACE BAR ar
ACTUATES THE Clear Unselected #T
SPEAKERICON #F| =[] Clear Beyond Loop

Mik #M
Invert

Reverse

Silence




The shift, option, command (38) and control keys are called modifier keys.
They don’t do anything by themselves, but they can modify the next
keystroke or mouse click. In Infinity, they are also used in combination to
momentarily put the program in either Selection Mode or Zoom Mode. For
details of how this is done, see “Using Momentary Selection Mode"” on
page 23 and “Using Momentary Zoom Mode"” on page 18.

The following are examples of keyboard command equivalents and instruc-
tions on how to execute them. For a full listing of all the keyboard com-
mand equivalents, see page 67.

TO EXECUTE: DO THIS:

3#8-X Hold down the Command key and
press the x key.

Shift-Option Press the Shift and Option keys at the
same time.

3B-Shift-[ Hold down the Shift and Command

keys and press the [ key.

UNDOING A COMMAND

Commands which change the soundfile can be undone by choosing Undo
from the Edit menu. The keyboard command equivalent is §-Z.

This function is possible only if Enable Undo is checked in the Preferences...
dialog. See “Enable Undo” on page 36.

VIEWING THE SOUNDFILE

After you open or create a soundfile, Infinity allows the soundfile to be
viewed in a variety of ways designed to increase the speed and ease of
editing the data. This section explains how to scroll the data, change the
magnification of the display, and manage multiple windows.

SCROLLING THE SOUNDFILE DATA

Infinity provides several convenient options for scrolling the soundfile data
in the Mainview. The soundfile data can be scrolled both horizontally and
vertically.

TO: DO THIS:

Scroll by small increments Click on an arrow in a scroll bar, or
press the appropriate arrow key.

Scroll by one window increments  Click on a grey area in a scroll bar, or
press Shift and the appropriate arrow
key.

Scroll full left and center vertically. Press the Home key.



CHANGING THE DISPLAY RESOLUTION

USING THE DISPLAY SCALE ICON

The display resolution of the Mainview can be changed by using the Display
Scale icon on the Palette or the keyboard command equivalents.

+
€

e To double the vertical display resolution, click on the up arrow or press
3-up arrow

¢ To halve the vertical display resolution, click on the down arrow or
press &-down arrow

¢ To double the horizontal display resolution, click on the right arrow or
press 3-right arrow

¢ Halve the horizontal display resolution, click on the left arrow or press
38-left arrow

e Zoom to the extreme setting, press Option and click on the appropriate
arrow or press the appropriate arrow key.

I USING THE FIT SELECTION ICON

Clicking on the Fit Selection icon will cause a selected region to fill the
Mainview Display. The keyboard command equivalent is 38-F.

ﬁ USING ZOOM MODE IN THE OVERVIEW

When a soundfile is opened, the Overview is in Zoom Mode. In Zoom
Mode, a view indicator can be dragged around the area of the soundfile
you want to see in the Mainview. This area then fills the Mainview display.

To chose an area of the soundfile for viewing in the Mainview:
1. Move the cursor into the Overview display.

The cursor turns into a cross. The Zoom icon on the Palette video-
reverses to show that this display is in Zoom mode.

2. Place the cursor at the corner of the area you want to display and then
click-drag the mouse over the area.

A view indicator box appears around the area you have chosen.
3. Release the mouse.

The view indicator remains around the area you have chosen. The
Mainview now displays the selected area.



USING ZOOM MODE IN THE MAINVIEW

The view indicator can be used directly in the Mainview itself, by placing
the Mainview in Zoom Mode.

To put the Mainview in Zoom Mode:
1. Click on the Zoom Mode icon in the Palette.

The icon begins to blink and the message “Choose a Window for Zoom
Mode” appears in the Status Display area of the Palette.

2. Move the cursor into the active window and click in the Mainview.

The cursor becomes the cross cursor. The Zoom Mode icon on the
Palette video-reverses to show that the Mainview is in Zoom Mode.

You may now drag a view indicator around any region in the
Mainview. The display will automatically scroll if the view indicator is
dragged past the edge of the display. The view indicator can also be
dragged from the first click inside the Mainview.

To put the Mainview back into Selection Mode,
1. Click on the Selection Mode icon in the Palette.

The icon begins to blink and the message “Choose a Window for
Selection Mode” appears in the Status Display area of the Palette.

2. Move the cursor into the active window and click in the Mainview.

The cursor becomes the I-beam cursor. The Selection Mode icon on the
Palette video-reverses to show that the Mainview is in Selection Mode.

You may now select data in the Mainview as before.

USING MOMENTARY ZOOM MODE

Infinity can be put into Zoom Mode temporarily by pressing <control-shift>.
This is useful for quickly zooming a region in the Mainview. The cursor will
become the cross cursor and all active displays will remain in Zoom Mode as
long as this key combination is pressed. When the key combination is
released, all displays go back to their previous modes.

USING FULL ZOOM IN AND FULL ZOOM OUT

The horizontal display resolution of the Mainview can be set to its extreme
in one step.

TO: DO THIS:

To zoom to minimum resolution Select Full Zoom Out from the Display
menu, or double-click on the Mainview
in Zoom Mode.

To zoom to maximum resolution Select Full Zoom In from the Display
menu.



CHANGING SEPARATORS, UNITS AND SCALES

SHOW ZERO CROSSING

This item places dotted lines at the zero crossing of tracks in the Overview
and Mainview.

SHOW TRACK DIVIDERS

When checked, this item places solid lines between the tracks in the
Overview and Mainview.

VERTICAL SCALE UNITS

This item allows either percentage of full scale or sample value to be
displayed on the Vertical Annotation in the Mainview and the Status
Display Area of the Palette.

HORIZONTAL SCALE UNITS

This item allows the units shown on the Horizontal Annotation of the
Mainview and all other time displays to be chosen. The pop-up menu
choices are Samples, Hours:Minutes:Seconds:Milliseconds, SMPTE 24 FPS,
SMPTE 25 FPS, SMPTE 30 FPS, and SMPTE 30 FPS Drop.

MANAGING MULTIPLE WINDOWS
Windows can be arranged by using the Tile Windows and Stack Windows
commands in the Windows menu.
e To show all open windows without overlapping, select Tile Windows.

e To stagger all open windows at maximum size, select Stack Windows.

HIDING THE OVERVIEW

More space in the active soundfile window can be created by using the
Hide Overview command in the Display Menu. Selecting this command
causes the Overview of the active window to disappear. When the active
window has its Overview hidden, the menu item reads “Show Overview".
Selecting Show Overview will put the Overview back in the active window.



LISTENING TO THE SOUNDFILE
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SETTING-UP SOUND PLAYBACK

The Sound Playback menu contains a list of the devices which are currently
installed. Choosing an item will direct the soundfile playback through the
selected device. Choosing Mac 8, or Mac 16 connects Infinity the Apple
Sound Manager. ‘Mac 8 bit’ presents 8 bit data to the Sound Manager and
‘Mac 16 bit’ presents 16 bit data to the Sound Manager. (The Sound
Manager 3.0 or later must be present. If not, ‘Mac 16 bit’ will present 8 bit
data to the Sound Manager.) Interpolation of data occurs when the sample
rate of the Mac is different than the sample rate of the data. The Sound
Manager distorts the sound when there are not enough machine cycles to
interpolate the data. If this occurs, there are two things to try. The first is to
use ‘Mac 8 bit’, since the Mac is faster at interpolating 8 bit data. The
second is to set the sample rate of the Mac to the Sample rate of the data.
See the Sound control panel to adjust Sound Manager sample rates.

USING THE SPEAKER ICON

The soundfile can be played by clicking on the Speaker icon in the Palette.
Click the icon again to stop playback. Pressing on the <space bar> is the
keyboard command equivalent for the Speaker icon. Playback in the active
soundfile window is determined by the following conditions:

IF: THEN:

No data is selected The track(s) containing the insertion
point play from the beginning of the
soundfile.

The soundfile has loop points The track(s) containing the insertion

point are played from the beginning
and continue to loop until the Speaker
icon is clicked again.

Data is selected Just the selected region is played. The
selection contains both loop points
The selection is played and loops until
the Speaker icon is clicked again.

Only the loop data is selected Just the loop will play until the
Speaker icon is clicked again.

A looping tool is the active window Both tracks of the soundfile are played
from the beginning regardless of any
insertion point or selection.

Note: In a stereo soundfile, data is played back through the audio
channel that corresponds to the track number. Data on Track 1 plays
through the Left channel; data on Track 2 plays through the Right
channel.



EDITING THE SOUNDFILE

In addition to automated looping tools, Infinity has a sophisticated wave-
form editing environment. The following section describes how to select
data and use the editing tools to change it.

SPECIFYING WHERE TO CHANGE SOUND DATA

The first step in editing the soundfile data is to identify which data are to
be changed. In Infinity, as in many other Macintosh applications, data is
selected by using the insertion point and the I-beam cursor. Data can be
selected in both the Overview and the Mainview.

USING SELECTION MODE IN THE MAINVIEW

When a soundfile opens, the Mainview is in Selection Mode. Selection
Mode is used to change the current selection or insertion point. When the
cursor is moved into the active Mainview display, it becomes the I-beam
cursor. The Selection icon on the Palette video-reverses to indicate that the
Mainview is in Selection Mode. The I-beam cursor can be used to place the
insertion point or make a selection anywhere in the soundfile.

PLACING THE INSERTION POINT

The insertion point is the blinking vertical line which appears in both the
Overview and the Mainview. It can be moved only in Selection Mode by
using the I-beam cursor. It marks the place where data will be inserted or a
boundary of a region to be selected.

TO: DO THIS:

Place the insertion point Click once in the Mainview at the
desired location. In a stereo soundfile,
the insertion point appears in both
tracks.

Place it in only one track Hold down the Option key and click at
the desired location.

Extend it to the other track Hold down the Control key and click in
the other track. Click again to remove
it.
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SELECTING DATA

There is a variety of ways to select data in Infinity. Selected data become
video reversed to show that they are selected. The Mainview will automati-
cally scroll during the selection if the cursor is dragged beyond the data

displayed in the Mainview.
TO:

Select a region in one track

Select a region in both tracks

Lengthen the selection

Shorten the selection

Extend selection to the other track

Select a whole track

Select all the data in the soundfile

Select data inside the loop points

Deselect a region

DO THIS:

Drag through the region, or Optionclick
at the start, then Shift-click at the end.

Drag across the two tracks, or click at
the start of the region, then Shift-click
in the other track at the end.

Point at the new start or end and Shift-
click. You can then drag to a different
endpoint.

Point near the current end, Shift-click,
then drag to a different endpoint.

Hold down the Control key and click in
the other track. Click again to remove it.

Double-click in the track; or place the
insertion point in the track and choose
Select All (88-A) from the Edit menu.

Double-click in one track and drag to
the other; or Shift double-click in the
other track; or place the insertion point
in both tracks and choose Select All
from the Edit menu.

Choose Select Loop from the Edit menu.

Place an insertion point anywhere.



USING SELECTION MODE IN THE OVERVIEW

Data can also be selected in the Overview by placing the Overview in
Selection Mode. The insertion point and data selection behaviors are
exactly the same as in the Mainview.

To put the Overview in Selection mode:
1. Click on the Selection icon in the Palette.

The icon begins to blink and the message “Choose a Window for
Selection Mode” appears in the Status Display area of the Palette.

2. Move the cursor into the active window and click in the Overview.

The cursor becomes the I-beam cursor. The Selection icon on the Palette
video-reverses. Use the I-beam cursor to select any region in that
Overview.

To put the Overview back into Zoom Mode,
1. Click on the Zoom Mode icon in the Palette.

The icon begins to blink and the message “Choose a Window for Zoom
Mode"” appears in the Status Display area of the Palette.

2. Move the cursor into the active window and click in the Overview.

The cursor becomes the cross cursor. The Zoom Mode icon on the
Palette video-reverses to show that the Overview is in Zoom Mode.

USING MOMENTARY SELECTION MODE

Infinity can be put into Selection Mode temporarily by pressing <shift-
option>. This is useful for quickly selecting a region in the Overview. The
cursor will become the I-beam cursor and all active displays will remain in
Selection Mode as long as this key combination is pressed. When the key
combination is released, all displays go back to their previous modes.
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USING THE EDITING FUNCTIONS
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This section describes the edit functions shown in the Edit menu as they
operate without the use of the Blending feature. See “Using Edit Blending”
on page 31 for the details of how this feature effects the edit functions.

All of the functions described below can be reversed using the Undo
command in the Edit menu, provided that Undo is enabled in the Prefer-
ences... dialog. See “Customizing Your Environment” on page 36 for the
details.

When an edit operation is done on a soundfile, the contents of the Clip-
board is stored as the soundfile’s previous Clipboard. For a Cut or Copy, the
following steps take place:

e The application Clipboard is updated.
e The soundfile stores the new Clipboard as its new Clipboard.

e For a Clear, Clear Unselected, or Paste, the soundfile stores undo
information to undo the edit.

¢ You can go back to any document, any time after it has been edited,
and do an undo.

¢ The soundfile uses the new Clipboard or the undo information, which-
ever is available, to undo the edit.

e If the soundfile’s new Clipboard information was used, and if that
information is the same as the application Clipboard, then the applica-
tion Clipboard is replaced with the soundfile’s previous Clipboard.

¢ This has the effect of undoing the Clipboard as well as the soundfile
edit.

® You can go back to any document, any time after it has had an undo
and do a redo.

e [f the undo had the effect of undoing the Clipboard, then redo will
have the effect of restoring it.

cuT

Cut removes precisely the number of samples that are selected. Any data to
the right of the cut is shifted left by exactly that amount. Blending is
performed by combining data just inside the selection with data that was
not cut on the opposite end of the selection. Hence, if you use cut to
remove a noise spike, you may find, depending on the size of the cut and
the amount of blending used, that part of the spike still remains.

If an Undo Cut occurs later, the cut data is replaced in the soundfile and the
previous Clipboard data is returned to the Clipboard.

¢ To cut data, select the data to be removed. Then choose Cut from the
Edit menu. The keyboard command equivalent is 38-X.



COPY

The Copy function copies data into the Clipboard without removing it from
the soundfile. Since the Clipboard can hold only one item at a time, any
data previously in the Clipboard is lost.

¢ To copy data, select the region to be copied. Then select Copy from the
Edit menu. The keyboard command equivalent is 3-C.

PASTE

The Paste function inserts data from the Clipboard into the soundfile.
Infinity will paste data into the soundfile at the insertion point or replace a
selected region with the Clipboard data. Since the original data remains on
the Clipboard, it can be pasted any number of times. The keyboard com-
mand equivalent is &8-V.

When Pasting into a soundfile that has no samples, the soundfile will
acquire the sample rate and MIDI Note Number of the first data pasted into
it.

Normally, when Pasting or Mixing with an insertion point, the new data is
inserted before the first sample of the group of samples represented by the
pixel under the insertion point. The exception to this rule is when the
insertion point is on the last pixel in the soundfile window. In that case, the
new data is added after the last sample in the soundfile. Blending occurs
between the end of the original sound and the pasted data.

e To paste at the insertion point, place the insertion point where the
region of pasted data is to begin. Then select Paste from the Edit
menu. The data to the right of the insertion point is moved over and
the Clipboard data is inserted.

e To replace a selected region with the Clipboard, select the region to be
replaced. Then select Paste from the Edit menu. The selected data is
deleted and the Clipboard data is inserted in its place. Data to the right
of the selection is moved to fit the newly pasted region.

Attempting to paste a stereo Clipboard into one track, evokes this dialog.

Fewer tracks are indicated than are
in the clipboard. Press OK to ignore
extra clipboard tracks.
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Attempting to paste a mono Clipboard into two tracks, evokes this dialog.

MMore tracks are indicated than are in
the clipboard. Press OK to paste
Zeros in edtra tracks.

CLEAR

The Clear function is the same as Cut except the Clipboard remains un-
changed. The data to the right of the cleared region are moved to fill up the

gap.

e To clear data, select the region to be cleared. Then select Clear from the
Edit menu. The keyboard command equivalent is 3-B or Delete.

CLEAR UNSELECTED

The Clear Unselected function clears all the data around a selected region of
the soundfile. After the unselected data are cleared, the selected region is
moved to the front of the soundfile.

¢ To clear unselected data, select the region to be left unchanged. Then
choose Clear Unselected from the Edit menu. The keyboard command
equivalent is §8-T.

CLEAR BEYOND LOOP END
This option clears data after the loop.

MIX

The Mix function combines the contents of the Clipboard with the soundfile
data in a 1:1 ratio. Infinity will mix data into the soundfile starting at the
insertion point or mix into a selected region. The keyboard command
equivalent is 3-M. There must be data in the Clipboard for the Mix function
to be enabled. You can mix into a selection or at an insertion point.

¢ To mix data starting at the insertion point, place the insertion point
where the mixture is to begin. Then select Mix from the Edit menu. The
data in the Clipboard will be mixed with the soundfile in a 1:1 ratio,
starting at the insertion point and going to the end of the Clipboard.
When mixing to an insertion point, the Clipboard selection is placed at
the insertion point. Initial blending (if enabled) occurs before the
insertion point. After the insertion point, all of the Clipboard is mixed,
even if this means extending the length of the soundfile.



¢ To mix data into a selected region, choose Mix from the Edit menu. The
Clipboard is mixed with the selected data from the beginning of the
selection through the duration of the Clipboard or the selected region,
whichever is shorter. When mixing into a selection (with no blend), the
mixed data is limited to the minimum of the soundfile selection or the
Clipboard selection. This keeps changes within the selection.

When there is a blend, the blend is done outside the selection and different
blends are used for beginning and end, whatever can be worked out
between the soundfile and the Clipboard.

In blending during the mix, the soundfile is never tapered. The Clipboard is
tapered up in the beginning and down at the end (depending on the
amount of data available to construct the blend).

When mixing into a soundfile that has no samples, the soundfile will
acquire the sample rate and MIDI Note Number of the first data pasted or
mixed into it.

Normally, when Pasting or Mixing with an insertion point, the new data is
inserted before the first sample of the group of samples represented by the
pixel under the insertion point. The exception to this rule is when the
insertion point is on the last pixel in the soundfile window. In that case, the
new data is added after the last sample in the soundfile.

INVERT

The Invert function changes the sign of the soundfile data. In other words,
it inverts the phase of the waveform by 180 degrees.

¢ To invert the soundfile data, select the region to be inverted. Choose
Invert from the Edit menu. The selected data are then changed.

REVERSE

The Reverse function reverses the order of the sample data in time, end for
end. (e.g. a backwards cymbal roll)

e To reverse the soundfile data, select the region to be reversed. Choose
Reverse from the Edit menu. The data are then switched in order, the
last sample coming first.

SILENCE
The Silence function zeroes selected data in the soundfile.

e To silence soundfile data, select the region to be silenced. Choose
Silence from the Edit menu. The sample values of the selected data are
then zeroed.
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NORMALIZE

The Normalize function increases the gain of a selected region until the
largest sample in the region is at 100% amplitude. Normalize insures the
maximum signal to noise ratio from your sample playback instrument.

¢ To normalize soundfile data, select the region to be normalized.
Choose Normalize from the Edit menu. The selected region will be
increased in amplitude until the largest sample in the region is at full
scale.

CHANGE GAIN...

The Change Gain dialog allows the level of the soundfile to be adjusted to
avoid clipping during processing. Selecting Change Gain... from the Edit
menu will cause the following dialog to appear:

Soundfile:  strings A#4

Change Gain (db): [ o|[&
=)

The gain of the selected data can be changed by using the slider or by
typing in the text box. The range of the control is from -12 dB to +12db.
Clicking on the arrows will increment the setting by 1 dB. Clicking in the
grey area will increment the setting by 3 dB.

A typical application for the Change Gain function is adjusting the level of
a normalized soundfile downwards before mixing it with another
soundfile. After processing, the soundfile can be returned to its original
level by changing the gain an equal amount in the opposite direction.

e To change the amplitude of soundfile data, select the data to be scaled.
Choose Change Gain... from the Edit menu. Set the desired gain
change using the controls. Click OK to process the data. Changing Gain
can be undone.

CREATE/DELETE LOOP POINTS

The Loop Points icon adds loop points to a file or deletes them from a file
which has them.

¢ To create loop points in a soundfile, click on the Loop Points icon in the
Palette, or choose Create Loop Points from the Edit menu. The key-
board command equivalent is 3-P. The loop points appear in the
soundfile and the menu item changes to read Delete Loop Points.



¢ To delete loop points from a soundfile, click on the icon again. The
loop points will disappear and the menu item will change back to read
Create Loop Points. The deleted loop points can be returned to their
original positions by clicking on the icon a third time.

LOOP THE SELECTION
This command place the loop points at the ends of the current selection.

LOCATING LOOP POINTS

The Mainview can be scrolled to the position of either the loop start or
loop end points. The Loop Start icon is labeled 1. The Loop End icon is
labeled 2.

To center the Mainview on the loop start point, click on the Loop Start icon.
The keyboard command equivalent is 38-Shift -[.

¢ To center the Mainview on the loop end point, click on the Loop End
icon. The keyboard command equivalent is 38-Shift-].

Hold the Option key while clicking these buttons does a full zoom out of
the mainview display.

SET MIDI NOTE...

Choosing this item from the Edit menu or clicking on the MIDI Note
Number in the soundfile window displays the following dialog.

Soundfile:  strings A#4

MIDI Note Number:
ok ]

The MIDI Note Number tells Infinity the pitch of the soundfile. It is used in
Infinity’s looping algorithms and is critical to the operation of the Freeze
Looper. Empty soundfiles will acquire the sample rate and MIDI Note
Number of the first data pasted or mixed into them.

e To change the MIDI Note Number, choose Set MIDI Note... from the
Edit menu. Data can be entered by typing in the text box or by using
the scroll bar. Either the MIDI Note Number or the musical pitch (e.g.
C#3) can be entered. Clicking in the grey area increments by one
octave.
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POSITIVE GOING
ZERO CROSSING

AUTO-ZERO

When this item is checked in the Edit menu, Infinity constrains the bound-
aries of selected regions to positive going zero crossings in the sample data.
This helps you to avoid creating pops and clicks when you cut and paste.
Infinity will always expand the selection to the positive going zero crossings
closest to the initial selection boundaries. When two tracks are selected,
Track 1 is used as the guide track.

=] Mono Strings - No Backup FE|
100 e
50 [ |

L0 TR __ o s

501
-100 ]

To constrain the selection boundaries to positive going zero crossings in the
soundfile, check Auto-Zero.

SHOW CLIPBOARD...
Choosing Show Clipboard... in the Edit menu calls the following dialog.

=[1=——— Clipboard
Source sound file: bross A®3
Selection size: 10,121
Track count: 1
Soample raote: 44100

Begin blend size: O
End blend size: 0
Gegin loop: 2,200
_End loop: T, a0

@




The dialog gives information about what data is currently in the Clipboard.

Source Sound File: The name of the soundfile from where the current
Clipboard contents originated.

Selection Size: The size of the selected region in terms of the currently
selected units used in the Horizontal Annotation. (in this case, samples)

Track Count: The number of tracks in the Clipboard.
Sample Rate: Expressed in Hertz

Begin Blend Size: The number of samples (or duration) before the
selected region which will be used to blend the region when pasting or
mixing.

End Blend Size: The number of samples (or duration) after the selected
region which will be used to blend the region when pasting or mixing.

Sound data which has been copied into the Clipboard in Infinity cannot be
shared with Sound Designer or Alchemy, as these programs have incom-
patible Clipboard formats.

USING EDIT BLENDING

Enabling the Blending function causes Infinity to blend the edges of data
segments that are moved during Cut, Paste, Clear, Mix, Invert, Reverse,
Silence, Normalize, and Change Gain operations. This smooths the transi-
tion so that abrupt changes in the sound are avoided. The following figures
show the effect of blending as used with the Cut and Clear functions.

1.
2.

Select a region of data.
Choose either Cut or Clear SELECTED
from the Edit menu. REGION
Data on both sides of the — BLEND TAPER
selection boundaries are \/ y
tapered. The remaining
selected data are removed
from the soundfile. -
The data on the right are -
moved to close the gap and -
are crossfaded with the data | -
on the left.

BLEND TIME
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The illustration below describes the effect of Blending on the Paste function.

1. Place the insertion point at
the location where data is
to be pasted.

. INSERTION POINT
2. Select Paste from the Edit

menu. ﬁ#\ % »
»

3. Data on either side of the
insertion point is tapered.
The data on the right are
movedto create a gap to fit
the Clipboard data.

4. Clipboard data are tapered |<_.|

and crossfaded with the CLIPBOARD SELECTION SIZE
soundfile data.

CLIPBOARD DATA

Cut or Copy will put the selected data in the Clipboard. If blending is
enabled and the blend time is greater than zero, the leading and trailing
samples will also be put on the Clipboard. If the selected region is at the
end of a file, fewer or no trailing samples will be captured. If the selected
region is at the beginning of a file, fewer or no leading samples will be
captured. You can see how many leading and trailing samples are captured
with “Show Clipboard”. These are labeled “Begin Blend Size” and “End
Blend Size"”, respectively.

Paste will similarly identify independent leading and trailing blend regions
around the selection or insertion point. Paste will then compare its leading
blend region with the leading blend region of the Clipboard and choose
the smallest. Similarly, for the trailing blend time. The Paste is then per-
formed with these new blend times. Note that blending occurs outside of
the original selection and outside of the Paste’s selection.

Cut removes precisely the number of samples selected in the file. In order
to blend the result, samples on both side of the beginning of the selection
are merged with samples on both sides of the ending selection, provided
that blending is enabled and there is a non-zero blend time. The size of the
merge is given by the blend time. It must be noted, therefore, that cutting
some samples does not necessarily completely remove them. To completely
remove the center-most samples, the selection size must be larger than the
blend time.

Clear Unselected does no blending.

Clear is the same as Cut, except no samples go to the Clipboard. Blending in
Clear works the same as blending in Cut.



Normally, when Pasting or Mixing with an insertion point, the new data is
inserted before the first sample of the group of samples represented by the
pixel under the insertion point. The exception to this rule is when the
insertion point is on the last pixel in the soundfile window. In that case, the
new data is added after the last sample in the soundfile. Blending occurs
between the end of the original sound and the pasted data.

ADJUSTING THE BLEND PARAMETERS

Infinity allows the length and taper of the crossfade used in edits to be
adjusted. Clicking on the Blend... command button in the Preferences...
dialog will evoke the Edit Blend Settings dialog shown below.

Edit Blend 5ettings

Blend Time (msec) [ I
Blend Taper [ oM

Lirear Equal Prwer

Lok ]

Blend Time: To change the length of the crossfade, use the Blend Time
scroll bar or type directly into the text box to adjust the duration. The
initial setting is 10 milliseconds. The range is from 0 milliseconds to 2,000
milliseconds. The most useful range for normal editing functions is from 10
to 50 milliseconds. (The scroll bar has exponential scaling so there is plenty
of resolution around the most useful settings.) The illustration below shows
the effect of changing the Blend Time control.

BLEND TIME=0 MILLISECONDS

X BLEND TIME=10 MILLISECONDS

> < BLEND TIME=25 MILLISECONDS




Blend Taper: The slope of the crossfade can be changed by using the Blend
Taper scroll bar or text box. The range of settings is from 0 (linear) to 100
(equal power). The initial setting is 0 (full linear). The illustration below
shows the effect of changing the Blend Taper control.

BLEND TAPER=100
EQUAL POWER

>< BLEND TAPER=0

LINEAR

Linear taper should be used for editing simple periodic waveforms like solo
instruments. Equal power taper should be used when editing complex non-
periodic waveforms like string sections or noise.

SAVING THE SOUNDFILE
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SAVE

Because Infinity uses disk based documents, changes to the soundfile are
saved as they occur. The Save command in the Edit menu updates the
backup file (if one exists) so that a Revert to Backup command will revert
the soundfile to the most recently saved backup. The Save command in the
Edit menu is selectable after a change has been made in the soundfile.

If the soundfile has been changed and a backup file exists, closing the
soundfile will cause the following dialog to appear.

Save changes to the Infinity document
‘Carillon*1-EP5' before closing?

SAVE A COPY...

Use the Save a Copy... command to save the soundfile in a different folder,
with a different file name, or in a different file format. This command is
useful to make a series of samples for later comparison.



To use the Save a Copy... command:

1. Choose Save a Copy... from the File menu. The Save a Copy dialog box
appears.

| @ Audio Files  # | = Macintosh HD
[ envelope Files

Eject

T

= F2-ASa2_02.

= F2-ASa2_02R
;‘: F2-looped AIFF.1.l E m
~| F2=loopedAlFF.1.R -

Save soundfile as:
|Etrinuiwith S5FR LOOP [
3 Audio IFF i Sound Designer

3 Audio IFC i Sound Designer 11

2. Type a new file name in the Save Soundfile As text box.

3. Choose a file format from the four options listed.

USE THIS FORMAT: TO SAVE AS A:

Audio IFF Apple Audio Interchange File Format
document

Audio IFC Apple Audio Interchange File Format-C
document

Sound Designer | Digidesign Sound Designer | mono
soundfile

Sound Designer Il Digidesign Sound Designer [l mono or

stereo soundfile

4. Click on Save. A copy of the active soundfile will be stored on disk with
the name and file type specified.

REVERTING TO THE LAST SAVED VERSION

Choosing Revert to Backup from the File menu causes the soundfile to
revert to the version last saved with the Save command. This command is
enabled only if a backup file has been created for the active soundfile.
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CUSTOMIZING YOUR ENVIRONMENT

36

When Infinity is first started, the look of the soundfile windows is prede-
termined. The appearance of the soundfile windows can be customized and
some of Infinity’s behaviors can be modified by using the Preferences...
dialog in the Display menu.

Freferences

Ll Blending Blend...
[+ Create Backup Files

4 Playback Auto-Reset [ Scroll ATter Playback

BLENDING
Checking this item enables the Blending function.

CREATE BACKUP FILES

When this item is checked, opening or saving a soundfile will create a
temporary backup copy of the file. This allows the Revert to Backup
command in the File menu to be used.

Files that are opened with Create Backup Files checked will display the
phrase “Backup Created” in their title bar. This indicates that there is a
copy of the last saved version of the soundfile. Each time Save is used, this
backup copy is deleted and the current sound is used to create a new
backup file.

Creating backup files can take an inconveniently long time when working
with large soundfiles. Also, there may be insufficient space on your hard
disk to store the backups. If either of these conditions apply, uncheck the
Create Backup Files item. The title bar for a file opened in this condition
will display the phrase “No Backup”.

NOTE: Be forewarned that when “No Backup” is displayed in the title
bar, any changes you make to the soundfile will be permanent unless
Undo is enabled.

PLAYBACK AUTO-RESET

If this item is checked, playback will occur from the beginning of the
soundfile unless a region is selected. If this item is not checked, playback
will begin from the point where it stopped the last time. This item should
remain checked for most applications.



SCROLL AFTER PLAYBACK

This item is initially not checked when you start Infinity. Checking this item
causes the Mainview to automatically scroll to the position where playback
stopped. This feature is most useful when working with the Mainview at
high display resolutions.

CUSTOMIZING THE SOUNDFILE WINDOW

The appearance of the soundfile window can be changed by using the
soundfile window options in the Preferences... dialog.

Show Zero Crossings: Show Track Dividers:
[+ e rwiew = Dwerwien
[ Mainwigns = Mainuigue
Horizontal Scale Units: | Samples s |

| Cancel | || [1]4 ||

¢ To display the dotted zero crossing lines, check the box next to Over-
view or Mainview.

e To display track divider lines, check the box next to Overview or
Mainview.

e To change the units on the Horizontal Annotation, use the pop-up
menu. See the reference section for more information about these
options.






Chapter 4: Looping Tools

he looping tools in Infinity are easy to use and provide extraordinary
results. To use them most effectively requires some understanding of the
types of sound you are working on and the way the tools operate on the
sound data. The following chapter explains, in detail, the operation of
Infinity’s looping tools.

MANAGING LOOP POINTS

REAL TIME LOOP ADJUST

Infinity allows the location of the loop points to be changed during
playback. To move a loop point during playback, drag it to its new location
by pressing somewhere near the base of the loop point in the Horizontal
Annotation. The loop points can be dragged over each other. The loop
point which is on the left then becomes the Loop Start.

e To move both loop points simultaneously, while preserving the loop
length, press the Option key while dragging either loop point.

The real time loop adjust feature can be used to rough set the loop points
when working with sounds that change over time. If you are working on a
stable loop, set the loop points around a region which is relatively stable in
pitch, timbre, and loudness. If you are making a loop which includes a
vibrato or tremolo, set the loop start and end to include several vibrato
cycles.

A more precise way to set the loop points is to use the Smart Auto-Scan
feature described below.
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UNDO LOOP MOVE

Undo Loop Move is on the edit menu. Undo Loop Move is enabled only
after loop points have been dragged in the sound window or moved using
the crossfade dialog window. Pressing Undo Loop Move undoes the
previous loop move. Pressing a second time redoes the previous loop move.
Edits: cut clear, paste, clear unselected, and reverse, when they change the
loop positions, will disable Undo Loop Move. If the loop points are not
changed by edits, Undo Loop Move remains enabled. Please remember that
normal edit Undo recovers any loop points changed by the edit. Using any
of the looping tools (except the Crossfade Looper) will disable Undo Loop
Move.

LOOP POINTS AND CLIPBOARD

The loop points are copied onto the clipboard. This occurs with a cut or
copy if both loop points are included in selection. Valid loops points in
clipboard show up as at least one non-zero value for the begin or end loop
time (see the Show Clipboard option in the Edit menu). The values dis-
played in Show Clipboard are relative to the beginning of the selection
when the cut or copy was performed. When Paste is used and loop points
are in clipboard, they are always pasted into the document.

LOOP POINTS DURING EDITS

The loop points are moved only if all tracks are selected in Cut, Clear, Paste,
and Reverse operations. Loop points are always moved for Clear
Unselected. The loop points are never moved for Silence and Invert opera-
tions.

If both loop points are in an area that is cut from the data, they are
deleted. Undo restores the previous loop points.

During Cut and Clear operations, a loop point that is within the selection is
moved to the new insertion point. (If this happens to both loop points, the
loop is deleted.) Loop points after the selection end point are moved
forward, “stuck” to their respective sample.

During Paste operations, where there is a selection, a loop point in the
selected region stays at the same number of samples after the selection
start point unless the pasted region is smaller than that offset. In that case,
it is moved to the first sample after the new pasted region. Loop points
after the selection end point are “stuck” to their respective sample. During
Paste operations where there is an insertion point, loop points after the
insertion point are moved backwards, “stuck” to their respective sample.

During the Clear Unselected operation, loop points in the discarded regions
are moved to the first or last sample of the soundfile. Loop points within
the selected region are “stuck” to their respective sample.

During the Reverse operation, loop points in the selected region are
reversed as if “stuck” to their respective sample.



LOOP POINTS IN OTHER FILE FORMATS

Two loop points exist in the AIFF and the Sound Designer | formats, the
sustain loop and the release loop. Currently, Infinity only deals with the
sustain loop.

In Sound Designer I, the sustain loop is called Loop 1 and the release loop
is called Loop 2. Infinity will read only Loop 1 from a Sound Designer file as
the sustain loop. When Infinity writes to a Sound Designer 1l file, all other
loops are lost.

THE CROSSFADE LOOPER

The standard crossfade loop is created by blending part of the attack
segment into the end of the loop segment of the soundfile to create a
smooth transition back to the loop start. Infinity’s Crossfade Looper allows
for precise control of the process and contains many enhancements includ-
ing a scalable looping display, a non-destructive audition feature, fully
adjustable crossfade parameters, and an intelligent loop point scanning
technology called Smart Auto-Scan. This section explains these features and
their controls.

E0=———— Crossfade Looper

Soundfite:

LOOPING DISPLAY

AUTO-SCAN ARROWS o [dd{~utc [Ma[ b autcDh] ;I [t [ o pp]

Loop Start

Loop End

AUTO-SCAN
MATCHING VALUE Crossfade Length (%): [100][€]

Crossfade Taper: [20][@]

Linear Equal Pwr
[ Audition Crossfade

Auto-Scan Settings... Do Crossfade

The soundfile can be auditioned while the Crossfade Looper is the active
window. Playback works by pressing the space bar or clicking on the
Speaker icon. If the cursor is in a text box, playback can be started only
with the Speaker Icon. Terminate playback by clicking on the Speaker icon
or pressing the space bar. During playback, unusable controls are grayed.
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ABOUT SMART AUTO-SCAN

This algorithm searches the soundfile for places where the sound at one
loop point matches the sound at the other loop point. The closeness of the
match and the number of places in the soundfile that are searched are
controllable using the Auto-Scan Settings dialog shown below.

Ao /ﬁ\r“m, AT s /f’\x\ﬁum
‘\u( I Ry, v iy W U

|« Autn}‘l*l Auta »| | | |« Autolﬁl’{ At »l

Loop End Loop Start

|"

Conventional "auto” functions move the loop points to the nearest zero
crossing or the nearest zero crossing with the same slope. Smart Auto-Scan
compares the amplitude and the phase of the major harmonics at the loop
points and searches until a good match is found. The result is a loop point
which always creates good crossfade loops, i.e. without unwanted phase
cancellations of the major harmonics. The illustration below shows the
result of a Smart Auto-Scan; the alignment of the waveforms is exact. The
slopes at the loop interface will blend after the crossfade is complete.

UNDERSTANDING THE DIALOG CONTROLS

Soundfile Menu: The Soundfile Menu shows the name of the last active
soundfile. All open soundfiles are listed in the menu. The Crossfade Looper
operates on the soundfile which is displayed in the menu.

Looping Display: The Looping Display shows the interface between the
loop end and the loop start. The vertical line in the middle of the display
shows the interface point. The left half shows the Loop End region, the
right shows the Loop Start region. Certain combinations of display resolu-
tion and loop point positions will show the loop point in the opposite
display. In this case, the loop point marker is shown as a vertical line.

The display resolution can be changed using the Display Scale Arrows on
the Palette. The position of the cursor is also shown in the Palette cursor
tracking display.

Auto-Scan Arrows: Clicking on a double arrow will cause Infinity to begin
searching for a matching loop point in the direction of the arrow. When
one is found, the loop point marker is moved to the new location.



Infinity will continue to search until it finds a matching value which is
greater than or equal to the value of the Matching Threshold set in the
Auto-Scan Settings dialog. If none is found, an audio signal will sound,
indicating the end of the search. The loop points will remain in their
original locations. Pressing <esc> or <command-period> will terminate the
search.

Clicking on a single arrow will move the loop point one pixel in the direc-
tion of the arrow. Pressing on a single arrow will cause the loop point to
move and slowly accelerate. The longer the arrow is pressed, the faster the
loop point will move.

Auto-Scan Matching Value: This displays the matching values found during
Auto-Scan searches. Watching this value during the search gives you an
idea of how closely the sound at the loop points is matching. Use this
information to change the Matching Threshold in the Auto-Scan Settings
dialog, if necessary.

Auto-Scan Settings: Clicking on the Auto-Scan Settings command button
will bring up the dialog shown below.

Auto-%can Settings

Matching Threshold: [ 40][&
Match Trial Points:

Lok ]

Matching Threshold: The Matching Threshold determines how closely the
loop end must match the loop start. The range of the control is from zero
to 100. Higher numbers require a closer match. A value of 100 equals a
perfect match. Non-periodic sounds typically have lower matching values
than periodic sounds.

Match Trial Points: This control changes the number of locations in the
soundfile which are searched during an Auto-Scan. The soundfile is first
divided by the number of Match Trial Points, then the search begins in the
direction of the arrow which was clicked. The range is from 10 to 1000.

Crossfade Length (%): This control adjusts the amount of attack data which
is crossfaded with the loop end to create a smooth transition back to the
loop start. The range is from 0% to 100% of the attack segment. If the loop
segment is shorter than the attack segment, then the crossfade length
percentage refers to the amount of the loop data which is effected by the
crossfade.
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THE FREEZE LOOPER

Crossfade Taper: This control adjusts the taper shape of the crossfade that
is used to blend the attack and loop segments. It is adjustable from 0
(linear taper) to 100 (equal power taper). It should be adjusted to provide
the smoothest transition between the attack and loop segments of the
sample. Use equal power taper for string sounds, choruses, and other non-
periodic sounds. Linear taper is best used with periodic waveforms like solo
instruments.

100
EQUAL POWER TAPER

a
>< 0

LINEAR TAPER

Linear taper should be used for editing simple periodic waveforms like solo
instruments. Equal power taper should be used when editing complex non-
periodic waveforms like string sections or noise.

Audition Crossfade: When the Audition Crossfade checkbox is checked,
clicking on the Speaker icon (or pressing the space bar) will compute the
crossfade loop and play it until the Speaker icon is clicked again. This feature
allows you to hear the crossfade without permanently changing the
soundfile.

Do Crossfade: Clicking on the Do Crossfade command button executes the
crossfade loop process. Pressing <esc> or <command-period> terminates the
process.
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The Freeze Looper is an automatic looping algorithm that creates a perfectly
seamless loop with no sonic variations. It is excellent for making short loops
in relatively periodic sounds like solo instruments, and for “freezing” the
timbre of decaying instruments that have clearly defined harmonics like
harp, piano, guitar notes, etc.

If the sound to be looped has nearly uniform waveshapes, the Freeze Looper
will change the aural qualities of the sound very little and result in a con-
tinuous uniform loop. If the Freeze Looper is used on a more complex sound,
the resulting loop will sound very different from the original.

The crossfade used in the Freeze Looper is different from a normal crossfade
loop in that a portion of the loop segment is blended into the attack rather
than a portion of the attack being blended into the loop. This modification

of the attack segment occurs every time a Freeze Loop is created.



HOW IT WORKS

The Freeze Looper quantizes all the sound energy in the loop to a precise
harmonic series, giving a waveform that is perfectly repeated in every cycle.
The Freeze Looper outputs a constant pitch equal to the average pitch of
the original loop segment.

The Freeze Looper uses the MIDI Note Number to set internal processing
parameters. Because these settings effect the results, the MIDI Note
Number should be set to the approximate pitch of the sound being looped.

The size of the loop segment is reduced by processing with the Freeze
Looper. The loop end point is moved to shorten the loop. The loop start is
left where it was before processing. This shortening is necessary because
the Freeze Looper uses an FFT algorithm that requires the number of
samples in the loop be equal to a power of two. The finished loop is also
shortened slightly so that it contains an integral number of waveform
periods. So, the output loop end point will be earlier than that which was
input.

If the computations cause the loop data to exceed 90% of maximum, the
entire file will be scaled so that the loop data are 90% of maximum and
thereby do not clip. Thus, data are scaled so no overflow occurs. When
scaling occurs, the user is notified with an alert which indicates how much
the data was scaled. The scaling information will allow you to maintain
volume control of your samples. If you are getting clipping in the fade from
the attack segment, check out that the crossfade taper may be set more
towards linear taper.

S[I=——-— Freeze Looper™ =

Soundfile: | brass A#3 v |

Pitch Control
r i MI0I Note i1 Pitch Detection

Pre-condition Data (%:[100|[&f
Crossfade Length (%): [ 0f

Crossfade Taper:

Linear Equal Puwr
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UNDERSTANDING THE DIALOG CONTROLS

Soundfile Menu: The Soundfile Menu shows the name of the last active
soundfile. All open soundfiles are listed in the menu. The Freeze Looper
operates on the soundfile which is displayed in the menu.

Pitch Control Radio: Previously, Freeze Looper had Pitch Detection built-in.
This means the harmonic series energy distribution and output tuning was
determined by an algorithm that detected the exact pitch of the original
loop. The MIDI note was used as an initial guide such that if the MIDI note
was way off, an incorrect result would occur. This algorithm is used when
you select the Pitch Detection radio.

Unfortunately, if you process a short loop (less than 20 cycles), the Pitch
Detection algorithm will not be precise and the result may be slightly out
of tune. Also, it may be the original sample was out of tune and you wish
to tune it up. In these cases, you should select the MIDI Note radio. This will
force the harmonic series energy distribution and output tuning to be
determined using the MIDI Note number of the sample and the standard
that A3 is 440Hz.

Pre-condition Data (%): The purpose of the Pre-condition Data feature is to
taper the data at the loop start and loop end so that all the energy compo-
nents in the loop begin and end on zero. The control has a range from 0%

to 100%. Any setting larger than a few percent leaves little or no energy at
the loop points to cause a click which might inject unwanted noise into the
process.

Increasing the Pre-conditioning percentage favors the timbre of the sound
near the middle of the loop. Using different values gives different aural
qualities to the resulting sound. The diagram below shows the effect of
changing the amount of the loop tapered by the Pre-conditioning process.
(The taper does not show up in the finished loop.)

o] !
| |
o | |
| |

LOOP DATA AMPLITUDE AS A FUNCTION
OF PRE-CONDITION DATA PERCENTAGE

25%

100%



Crossfade Length: This control sets the amount of the loop that is blended
with the attack segment. It is variable from 0% to 100% of the attack
duration. A large crossfade length will cause the attack to slowly blend into
the loop sound. A smaller crossfade length will create a quick but blended
transition between the two segments of the sample. A setting of zero
creates no crossfade.

ATTACK LOOP
SEGMENT SEGMENT

50%

| |

Crossfade Taper: This control adjusts the taper shape of the crossfade that
is used in the attack/loop merge. It is adjustable from 0 (linear taper) to 100
(equal power taper). It should be adjusted to provide the smoothest
transition between the attack and loop segments of the sample.

> 100
EQUAL POWER TAPER
> < 0
LINEAR TAPER

Linear taper should be used for editing simple periodic waveforms like solo
instruments. Equal power taper should be used when editing complex non-
periodic waveforms like string sections or noise.

Do It: Clicking on the Do It command button executes the Freeze looping
process. Pressing <esc> or <command-period> terminates the process.
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THE ROTATED SUMS LOOPER
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The Rotated Sums Looper creates seamless loops by randomly distributing
sonic irregularities throughout the loop. It is very effective with sounds that
have non-periodic waveforms like chorus, string orchestra, complex synth
patches, sounds that include noise, and so on.

=[[=———— Rotated Sums Looper™ §_|

Soundfile: | brass A#3 |

(<] Process the Loop Segment

Rotation Count: Eﬁm

(<] Merge the Attack and Loop Segments
Loop Start Test Points:
Crossfade Length (%):

Crossfade Taper:

Linear Equal Prwr

Uze thi= tool on pre-looped soundfiles anly. | Do It |

NOTE: Sounds must be pre-looped before using the Rotated Sums
Looper. Any clicks, pops or other irregularities will be distributed
throughout the loop and show up as noise. Use the Crossfade Looper
to smooth out the loop data before processing with the Rotated Sums
Looper.

Use the Smart Auto-Scan feature of the Crossfade Looper to place the loop
points before processing with the Rotated Sums Looper. This will insure
that the resulting loop will more closely match the tone color of the
original data.

If the computations cause the loop data to exceed 90% of maximum, the
entire file will be scaled so that the loop data are 90% of maximum and
thereby do not clip. Thus, data are scaled so no overflow occurs. When
scaling occurs, the user is notified with an alert which indicates how much
the data was scaled. The scaling information will allow you to maintain
volume control of your samples. If you are getting clipping in the fade from
the attack segment, check out that the crossfade taper may be set more
towards linear taper.



HOW IT WORKS

In a crossfade loop, all of the different frequencies in the sound make a
transition from one phase to another during the crossfade. This causes
different combinations of constructive and destructive interference at the
location of the crossfade. Because this happens for all frequencies at the
same point in the loop, a noticeable “bump” is produced by the crossfade
looping process.

The Rotated Sums Looper creates a seamless loop by adding together many
random rotations of the input loop, thereby distributing the irregularity of
the crossfade bump throughout the loop. This is a time domain solution to
the crossfade bump problem in complex sounds. The more rotations that
are chosen, the better the results, up to a limit that exists because of the
natural variations in the sound. The Rotated Sums Looper does not change
the length of the loop.

Because the Rotated Sums Looper chooses random amounts by which to
perform loop rotations, different trials using the same input sound will
yield different results.

UNDERSTANDING THE DIALOG CONTROLS

The Rotated Sums Looper divides the looping process into two distinct
phases; processing the loop data, and merging the attack and loop seg-
ments. These can be controlled separately and executed at different times.

With both phases of the process enabled, the loop data and the attack data
are altered every time the Rotated Sums process is run. It is sometimes
desirable to disable the attack/loop merge phase of the process, and do
several takes of processing the loop data without merging the loop with
the attack. This saves time and allows for selecting the best sounding loop
before the attack segment is altered by merging. After the best sounding
loop is found, the merge can be done separately by disabling the loop
processing phase.

Soundfile Menu: This menu has the same function as in the other loopers.

Process The Loop Segment: Check this item if you wish to apply the Ro-
tated Sums process to the data inside loop. When this item is not checked,
the slider labeled Rotation Count is inactive and no change will be made to
the loop data.

Rotation Count: The Rotation Count is the number of times that the loop
data will be rotated and added in the accumulator during the loop process-
ing phase. The range of the control is from 1 to 100. More rotations give
better results, up to a point, but take more time.

Merge The Attack And Loop Segments: Checking this item enables the
second phase of the looping process; merging the loop segment with the
attack segment of the sample. Enable this part of the process only when
you want to crossfade the loop data with the attack segment of the sound.
When this item is not checked, the sliders labeled Loop Start Test Points,
Crossfade Length, and Crossfade Taper are inactive.
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When Merge the Attack and Loop Segments is checked in the dialog,
Infinity will automatically search a number of points in the loop segment to
find the point which most closely correlates to the end of the attack
segment. The number of test points that are tried during the search can be
controlled using the Loop Start Test Points control. Processing time in-
creases as more points are tried.

When the best merge point is found, Infinity rotates the data in the loop

until the merge point is located at the loop start. The loop is then merged
with the attack segment. The type of crossfade that is used only modifies

the attack segment. The length and taper of the crossfade that is used to

merge the two segments can be controlled.

Loop Start Test Points: This controls the number of points that are tested
during the search phase of the merging process. It is variable from 0 to 100
points. A large number of test points results in a better attack/loop merge
but will also increase the processing time.

Crossfade Length: This control sets the amount of the loop that is blended
with the attack segment. It is variable from 0% to 100% of the attack
duration. A large crossfade length will cause the attack to slowly blend into
the loop sound. A smaller crossfade length will create a quick but blended
transition between the two segments of the sample. A setting of zero
creates no crossfade.

ATTACK LOOP
SEGMENT SEGMENT

50%




THE SPR LOOPER

Crossfade Taper: This control adjusts the taper shape of the crossfade that
is used in the attack/loop merge. It is adjustable from 0 (linear taper) to 100
(equal power taper). It should be adjusted to provide the smoothest
transition between the attack and loop segments of the sample.

> 100
EQUAL POWER TAPER
> < 0
LINEAR TAPER

Linear taper should be used for editing simple periodic waveforms like solo
instruments. Equal power taper should be used when editing complex non-
periodic waveforms like string sections or noise.

The SPR Looper uses a patented process which randomizes the phase of
each spectral component in the loop. SPR means Spectral Phase Randomiza-
tion. It is excellent for looping sounds which have very non-periodic
waveforms. It is especially good at looping complex sounds which require
exact preservation of the original tone color like string sections, choirs, and
so on.

[I=—— SPR Looper” ————

Soundfile: | brass A%3 w |

(] Process the Loop Segment

Pre-condition Data (%): [ 40|[&

[<] Merge the Attack and Loop Segments
Loop Start Test Points:
Crossfade Length (%%):

Crossfade Taper: :
Linear
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HOW IT WORKS

The SPR Looper is similar to the Rotated Sums Looper in that it rotates loop
data a random amount through the loop. The difference with the SPR
Looper is that it treats every constituent frequency of the loop separately.
This approach is more thorough than the Rotated Sums Looper. Because the
SPR Looper rotates each spectral component randomly, different trials using
the same input sound will yield different results.

If the computations cause the loop data to exceed 90% of maximum, the
entire file will be scaled so that the loop data are 90% of maximum and
thereby do not clip. Thus, data are scaled so no overflow occurs. When
scaling occurs, the user is notified with an alert which indicates how much
the data was scaled. The scaling information will allow you to maintain
volume control of your samples. If you are getting clipping in the fade from
the attack segment, check out that the crossfade taper may be set more
towards linear taper.

Performance Note: Sometimes the Rotated Sums Looper and the SPR
Looper have an undesirable effect on the output loop. The energy of
any transient sound in the loop will be distributed evenly over the
length of the loop. Clicks and pops will be output as relatively steady
state noise.

For example, when looping a close miked ‘cello, the bow rasp, which
normally occurs in phase with the rest of the waveform, is distributed
randomly across the loop. The result sounds like the ‘cello mixed with
tape hiss. We recommend that these two tools be used only with
instrumental groups or other random non-periodic waveforms.

UNDERSTANDING SPR CONTROLS

The SPR Looper divides the looping process into two distinct phases;
processing the loop data, and merging the attack and loop segments. These
can be controlled separately and executed at different times.

With both phases of the process enabled, the loop data and the attack data
are altered every time the SPR process is run. It is sometimes desirable to
disable the attack/loop merge phase of the process, and do several takes of
processing the loop data without merging the loop with the attack. This
saves time and allows for selecting the best sounding loop before the
attack segment is altered by merging. After the best sounding loop is
found, the merge can be done separately by disabling the loop processing
phase.

Soundfile Menu: This menu has the same function as in the other loopers.

Process The Loop Segment: Check this item if you wish to apply the SPR
process to the data inside loop. When this item is not checked, the slider
labeled Pre-condition Data (%) is inactive and no change will be made to
the loop data.



Pre-condition Data (%): The Freeze Looper and the SPR Looper both use the
Pre-condition Data feature before processing the loop data. The purpose of
this feature is to taper the data at the loop start and loop end so that all
the energy components in the loop begin and end on zero. The control has
a range from 0% to 100%. Any setting larger than a few percent leaves
little or no energy at the loop points to cause a click which might inject
unwanted noise into the process.

Increasing the Pre-conditioning percentage favors the timbre of the sound
near the middle of the loop. Using different values gives different aural
qualities to the resulting sound. The diagram below shows the effect of
changing the amount of the loop tapered by the Pre-conditioning process.
(The taper does not show up in the finished loop.)

o] !
| |
o | |
| |

LOOP DATA AMPLITUDE AS A FUNCTION
OF PRE-CONDITION DATA PERCENTAGE

25%

100%

Merge The Attack And Loop Segments: Checking this item enables the
second phase of the looping process; merging the loop segment with the
attack segment of the sample. Enable this part of the process only when
you want to crossfade the loop data with the attack segment of the sound.
When this item is not checked, the sliders labeled Loop Start Test Points,
Crossfade Length, and Crossfade Taper are inactive.

When Merge the Attack and Loop Segments is checked in the dialog,
Infinity will automatically search a number of points in the loop segment to
find the point which most closely correlates to the end of the attack
segment. The number of test points that are tried during the search can be
controlled using the Loop Start Test Points control. Processing time in-
creases as more points are tried.

When the best merge point is found, Infinity rotates the data in the loop

until the merge point is located at the loop start. The loop is then merged
with the attack segment. The type of crossfade that is used only modifies

the attack segment. The length and taper of the crossfade that is used to

merge the two segments can be controlled.

53



Loop Start Test Points: This controls the number of points that are tested
during the search phase of the merging process. It works as in the Rotated
Sums Looper.

Crossfade Length: This control sets the amount of the loop that is blended
with the attack segment. It is variable from 0% to 100% of the attack
duration. A large crossfade length will cause the attack to slowly blend into
the loop sound. A smaller crossfade length will create a quick but blended
transition between the two segments of the sample. A setting of zero
creates no crossfade.

ATTACK LOOP
SEGMENT SEGMENT

50%

| |

Crossfade Taper: This control adjusts the taper shape of the crossfade that
is used in the attack/loop merge. It is adjustable from 0 (linear taper) to 100
(equal power taper). It should be adjusted to provide the smoothest
transition between the attack and loop segments of the sample.

100
EQUAL POWER TAPER

a
>< 0

LINEAR TAPER

Linear taper should be used for editing simple periodic waveforms like solo
instruments. Equal power taper should be used when editing complex non-
periodic waveforms like string sections or noise.



THE SYNTHESIS LOOPER

The Synthesis Looper tool can be used to selectively smooth out lumpy
sounding frequencies in chorused and ensemble sounds. The new sound is
more stable and loop repetitions are less noticeable. This control is
achieved by allowing you to specify the sidelobe widths of the harmonic
series as a function of frequency. You can control the sidelobe widths to
continuously range from the wide sidelobes of the original ensemble sound
to the zero width sidelobes of the Freeze Looper.

This tool is appropriately used on chorused and ensemble sounds where the
instruments are playing the same notes or notes in octaves. This tool can
also be used as a sophisticated chorusing effect, to generate an ensemble
sound from a solo instrument sound.

This tool is designed for use on monaural sounds. Stereo sounds can be
processed, however, the phase relationships that determine stereo position-
ing will be lost. The resulting stereo sound will have a random phase
relationship, yielding a distributed spatial quality.

COMMENTARY

There are two classifications of sound. The first classification is solo instru-
ments (sans vibrato). These generate uniformly repeated waveforms. A
generic crossfade loop can be used to loop these sounds, however the best
results will be had using the Freeze Looper. The second classification is all
other sounds. These are sounds that change over time. Crossfade loop
quality becomes worse as the sounds become more complex. The SPR
Looper and Rotated Sums are most often used to loop these sounds.
However, a basic problem remains: No matter how perfectly the end of the
loop is connected to the beginning of the loop, the sound in between is
still of a quality that changes over time. Hence, you will always “hear the
loop” because the varying sound repeats itself, over and over again.

This quality of hearing the loop because the varying sound repeats itself, is
sometimes judged as a poor quality loop. It this case, the loop-maker is
really wanting for a tool to change the sound to one which does not have
as much temporal variation.

It is for this reason we have created the Synthesis Looper. This tool gives
you control over that aspect of the sound which creates temporal variation:
the harmonic sidelobe widths.
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SOME THEORY

Temporal variation occurs when two sinusoidal frequencies are not exactly
in tune. For example, if one sine wave generator is tuned to 1000 Hz (Hertz
or cycles per second) and another is tuned to 1001 Hz, a 1 Hz “beat note”
will be produced. A temporal variation will also occur when there is any
integer relation between the frequencies involved: if one sine wave
generator is tuned to 500 Hz and another is tuned to 1001 Hz, a 1 Hz beat
note will also be produced.

Many solo instruments (sans vibrato) generate uniformly repeated wave-
forms. These sounds contain energy at the fundamental pitch, and over-
tone pitches, which have frequencies that are EXACT integer multiples of
the fundamental frequency. These frequencies are called the harmonic
series. For example, an oboe play A-440 generates energy at frequencies
440 Hz, 880 Hz, 1320 Hz, 1760 Hz, etc. Zero energy is generated at any
other frequencies (except for perhaps white noise generated at all frequen-
cies by air rushing through the instruments).

The second chair oboe, who does not have as much precision in pitch,
might play an A-440 out of tune, yielding energy at frequencies 441 Hz, 882
Hz, 1323 Hz, 1764 Hz, etc. Notice how the differences in pitch increase
proportionately with the harmonic index (1, 2, 3, etc.). These two players,
playing together will generate a sound with a 1 Hz beat note (a 1 second
repeated variation in sound).

Now suppose there were 100 oboes playing together (with vibratos). What
would the energy as a function of frequency look like? Remember the bell-
shaped curve? Draw a line in the dirt, stand back and throw 100 pennies at
the line. Most of them will land close to the line and some of them will
land far from the line. The number of pennies per inch will be highest at
the line, and lower farther from the line. If you draw a graph of the
number of pennies per inch verses distance, you will plot a bell-shaped
curve. This is technically described as a Normal Probability Density Function
or Normal PDF. If there were 100 oboes players, each playing their version
of A- 440 together (with or without vibratos) , the energy distribution of
the fundamental pitch as a function of frequency would form a Normal PDF
around 440 Hz. The width of the distribution would depend on how good
the players were. If they were very good players playing in tune and no
vibratos, the width would narrow. If they were unskilled and/or added
vibratos, the width would be wider. Since this Normal PDF is energy as a
function of frequency, concentrated at a single frequency, it is described as
a frequency with Sidelobe energy.

These 100 players would also generate energy at the harmonic frequencies.
The energy distribution of the harmonics as a function of frequency would
also form a Normal PDF. As with two players in the example above, these
differences in pitch increase proportionately with the harmonic index. Add
to this some elementary arithmetic about playing in octaves and we get the
following rules:



¢ Rule 01: An ensemble composed of instruments playing the same note
or notes in octaves will form an energy distribution as a function of
frequency having energy at the fundamental frequency and integer
multiples of the fundamental frequency.

e Rule 02: The energy distribution at the fundamental frequency will
form a Normal PDF whose sidelobe width depends on the intonation
quality of the players: in-tune players will generate a narrower
sidelobes than players who are more out of tune.

e Rule 03: Each harmonic will have an energy distribution at its respec-
tive harmonic frequency that forms a Normal PDF. The sidelobe width
of each harmonic will increase in proportion to frequency with the first
harmonic being two times wider than the fundamental, etc.

There is a final rule for which the authors do not take credit: Energy cannot
be created or destroyed. Nor can energy change its frequency. Acoustic
energy can change its form to heat. None the less, if you are listening to
two flutes playing slightly out of tune, then at the moment at which there
is silence at your ears, there is also at least one loud sound somewhere else
in the room. Be advised that by moving your head, you will change what
you hear.

HOW IT WORKS

The Synthesis Looper tool calculates the energy at each fundamental and
harmonic frequency and allows you to specify the width of the sidelobes
the resulting looped sound will have. In this way, you could take the lumpy
sound of a highly out-of-tune ensemble and change it to the smoother
sound of a higher quality ensemble, making the variations in the loop
repetition less noticeable.

There are other possibilities, too. For example, you can change the first few
harmonics to focus the energy in the sidelobes to zero. This will stabilize
the sound and still provide the warmth of the ensemble at the higher
frequencies. You could also, in the extremes, make a soloist into an en-
semble or an ensemble into a soloist.

You can view the Synthesis Looper window by selecting it from the Looping
Tools menu item: First, you can use the pop-up menu at the top of the
dialog to select any of the open soundfiles for processing or playback. You
can also press the space bar or the speaker icon in the palette window to
play back the selected sound.

This tool performs one, or both, of two functions chosen using the
checkboxes Process the Loop Segment and Merge the Attack and Loop
Segments. The latter function is the same as that in the SPR Looper and
Rotated Sums Looper. It allows you to combine a looped sound into the
attack portion of the sound. You can use both tools simultaneously or you
can first create a satisfactory loop with Process the Loop Segment and later,
merge it using Merge the Attack and Loop Segments.
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4 Process the Loop Seqment

Pitch Control
m MIDI Mote i3 Pitch Detection

% Retained Noise: [ ][]
Sidelobe Width (%)

S0
Left Point: Freq:
wxio:[_g
23
0 /
i Sk 10K 15K 20K

(<] Merge the Attack and Loop Segments

Loop Start Test Points: [ zo/[@f 1]
Crossfade Length (%):

Crossfade Taper:

Linear Equal Pwr

oo )

If the computations cause the loop data to exceed 90% of maximum, the
entire file will be scaled so that the loop data are 90% of maximum and
thereby do not clip. Thus, data are scaled so no overflow occurs. When
scaling occurs, the user is notified with an alert which indicates how much
the data was scaled. The scaling information will allow you to maintain
volume control of your samples. If you are getting clipping in the fade from
the attack segment, check out that the crossfade taper may be set more
towards linear taper.

UNDERSTANDING SYNTHESIS LOOPER CONTROLS

The Synthesis Looper divides the looping process into two distinct phases;
processing the loop data, and merging the attack and loop segments. These
can be controlled separately and executed at different times.



With both phases of the process enabled, the loop data and the attack data
are altered every time the Synthesis Looper process is run. It is sometimes
desirable to disable the attack/loop merge phase of the process, and do
several takes of processing the loop data without merging the loop with
the attack. This saves time and allows for selecting the best sounding loop
before the attack segment is altered by merging. After the best sounding
loop is found, the merge can be done separately by disabling the loop
processing phase.

Process the Loop Segment: In the Process the Loop Segment section, there
are three controls. The Pitch Control allows you to choose MIDI Note or
Pitch Detection. Selecting the MIDI Note radio button will cause the
harmonic series frequencies to be determined using the MIDI note. If the
loop data is not in tune, incorrect harmonic amplitudes will be computed.
Selecting the Pitch Detection radio button will cause the harmonic series
frequencies to be determined by the loop data using the MIDI note as a
guide. This is accurate unless the data is too short.

% Retain Noise: The second control is the % Retain Noise slider and
number box. Some sounds have a characteristic background noise, that
when removed, makes the sound less natural. An example of this would be
a cello section, where the action of the bow on the string adds noise at all
frequencies. Other sounds may have background noise that is undesirable.
If this control set to 100, the noise floor on the output will be the same as
on the input. If it is set to 0, the noise floor will be completely removed.
Intermediate values set the noise floor (energy) proportionately.

Sidelobe Width (%): The third control is the Sidelobe Width (%) graph. This
specifies the output sidelobe width as a percentage of the fundamental
frequency. This percentage is multiplied by the fundamental frequency to
get a frequency variation that is used as the standard deviation of the
Normal PDF energy distribution. You use this graph by dragging either of
the points to a desired location to specify the desired sidelobe widths. Note
that whenever this window is selected and your cursor is over this graph,
you can view the coordinates of the cursor location on the Status Display
Area palette window. The sound of the result is very sensitive to the
position of the left point. For this reason, the two text boxes are provided
so that you can type in numbers, giving you more accuracy than dragging
the point on the graph. Note that the sidelobe width is specified as 10
times the percentage, that is, typing a 7 means .7 %.

Merge The Attack And Loop Segments: Checking this item enables the
second phase of the looping process; merging the loop segment with the
attack segment of the sample. Enable this part of the process only when
you want to crossfade the loop data with the attack segment of the sound.
When this item is not checked, the sliders labeled Loop Start Test Points,
Crossfade Length, and Crossfade Taper are inactive.
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When Merge the Attack and Loop Segments is checked in the dialog,
Infinity will automatically search a number of points in the loop segment to
find the point which most closely correlates to the end of the attack
segment. The number of test points that are tried during the search can be
controlled using the Loop Start Test Points control. Processing time in-
creases as more points are tried.

When the best merge point is found, Infinity rotates the data in the loop

until the merge point is located at the loop start. The loop is then merged
with the attack segment. The type of crossfade that is used only modifies

the attack segment. The length and taper of the crossfade that is used to

merge the two segments can be controlled.

Loop Start Test Points: This controls the number of points that are tested
during the search phase of the merging process. It works as in the Rotated
Sums Looper.

Crossfade Length: This control sets the amount of the loop that is blended
with the attack segment. It is variable from 0% to 100% of the attack
duration. A large crossfade length will cause the attack to slowly blend into
the loop sound. A smaller crossfade length will create a quick but blended
transition between the two segments of the sample. A setting of zero
creates no crossfade.

ATTACK LOOP
SEGMENT SEGMENT

50%

| |

Crossfade Taper: This control adjusts the taper shape of the crossfade that
is used in the attack/loop merge. It is adjustable from 0 (linear taper) to 100
(equal power taper). It should be adjusted to provide the smoothest
transition between the attack and loop segments of the sample.

100
EQUAL POWER TAPER

0
LINEAR TAPER

a
2




Linear taper should be used for editing simple periodic waveforms like solo
instruments. Equal power taper should be used when editing complex non-
periodic waveforms like string sections or noise.

THE SYNTHESIS LOOPER REPORT

But how should you set the Sidelobe Width (%) control? How should you
choose MIDI Note or Pitch Detection? The Synthesis Looper Report will
assist you in deciding these issues. Select the Report... button at the bottom
of the Synthesis Looper window. This causes the Synthesis Looper Report
window to be generated:

=[[I=-- Synthesis Looper Report EI

Soundfile: brass A#3

Fundamental (Hz): | 466.2 |

Amplitude Spectrum (dB)

-120 | v ol |h
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Sidelobe Width (%)
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]

] Sk 10K 15K 20k

) Log scale (® Linear scale
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This window “belongs” to the soundfile. The data in the window is com-
puted from the soundfile’s loop data at the moment you pressed the
Report... button. You may generate as many reports for a soundfile as you
desire. You may close a report by clicking the “go-away” box in the top
left. If you close a soundfile, all the reports for that soundfile are closed
automatically. You can also press the space bar or the speaker icon in the
palette window to play back the soundfile to which this report belongs.
Remember though, if you modified the soundfile after generating the
report, you will hear the new soundfile.

Fundamental (Hz): The Fundamental (Hz) number is the fundamental
frequency. It is computed using the MIDI Note number or the Pitch detec-
tion method selected when you pressed Report....

Amplitude Spectrum (dB): The Amplitude Spectrum (dB) is the amplitude
(square root of energy) of the loop expressed in Decibels. (Decibels are 20 *
log(value). Every 6 dB is a approximately factor of 2. in amplitude.).

Sidelobe Width (%): The Sidelobe Width (%) graph shows the sidelobe
width computed from the loop as a percentage of the fundamental
frequency. The scale presented is the same as the Sidelobe Width (%) input
graph in the tool. This sidelobe width is computed for the fundamental and
each harmonic as the standard deviation of the energy distribution around
the fundamental or harmonic. It is expressed as a percentage of the
fundamental frequency.

Note that whenever this window is selected and your cursor is over the
Amplitude Spectrum (dB) or Sidelobe Width (%) graphs, you can view the
coordinates of the cursor location on the Status Display Area palette
window.

Log Scale or Linear Scale: At the bottom of the report are radio buttons
labeled Log Scale and Linear Scale. The Log scale allows more resolution at
the low frequencies where the audio content is the most important. The
Linear scale should show an approximate linear increase in sidelobe width
as a function of frequency for ensembles where the instruments are playing
the same notes (with octaves allowed).

The report above is shown using the log scale. The report below is the same
report shown in linear scale. The data is that of a string section. Notice how
the sidelobe width increases approximately linearly with frequency. Use the
linear scale on a report of unprocessed loop data to help you establish
what settings to use in the Synthesis Looper Sidelobe Width (%)graph.

In this graph, you can easily see that the harmonics have frequencies which
are integer multiples of the fundamental frequency. Also, the Normal PDF
distributions in energy show up as narrow concave downward hyperbola
(in Decibels verses linear frequency). Notice how the higher frequency
harmonics are wider. These sidelobe widths are proportional to frequency.



Note that the above Sidelobe Width (%) graphs were generated using pitch
detection (see the note enclosed in the graph). Pitch detection was used
here because this note was slightly out of tune. You can determine this
because if the MIDI Note were used instead, the graph would appear:

Sidelobe Width (%)

a0
Cornputed using MIDT note.
25
0 =
o ak 10K 15K 20k

Normally, the sidelobe widths do not exceed 30% unless the expected
harmonic frequency is not aligned to the actual harmonic frequency. This
will happen when the MIDI Note is used for pitch control and the note is
out of tune.

The following graphs show the result of processing the data with the
Retain Noise checkbox clear and checked, respectively.
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Retain Noise unchecked:

Amplitude Spectra (dB)
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Notice how the Sidelobe Width (%) becomes flat above 12k Hz, as was
specified in the Sidelobe Width (%) of the Synthesis Looper tool.



With Retain Noise checked:

Amplitude Spectra (dB)
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Compare the above graph to the report of the unprocessed data and notice
how the noise floor has been computed to vary with frequency similar to
the initial data. Also notice that the presence of noise causes the Sidelobe
Width (%) computation to be slightly excessive in frequencies where the
noise is nearly the same amplitude as the harmonic.

HOW TO LOOP A SOUND:

First, set the sample’s MIDI Note to as near the correct pitch as possible
using A3 = 440Hz. Second, set the loop points. Note that the Synthesis
Looper will make the loop smaller to the next power of two (approxi-
mately). Open the Synthesis Looper tool. Set the Pitch Control radio to MIDI
Note if you believe your sample should be in tune according to the A3 =
440Hz equal tempered scale. If not, set it to Pitch Detection.
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Next, press the Report... button. On the report, select Log scale and place
your cursor precisely at the fundamental peak. Check that the Fundamental
(Hz): number is within a pixel’s accuracy of the Hertz number on the
floating palette. If it is not, then you are going to have pitch problems. If
you had checked MIDI Note you either specified the wrong note or the
data is not tuned to A3 = 440Hz equal tempered scale. Either re-specify the
note or use Pitch Detection. If you had checked Pitch Detection, then your
MIDI note may be off. The MIDI note was used as an initial guide by the
pitch detection algorithm. If the MIDI note is way off, an incorrect result
would occur. Unfortunately, if you process a short loop (less than 20 cycles),
the Pitch Detection algorithm will not be precise and the result may be
slightly out of tune.

Next, review the Sidelobe width (%) graph. Normally, the sidelobe widths
do not exceed 30% unless the expected harmonic frequency is not aligned
to the actual harmonic frequency. This will happen when the MIDI Note is
used for pitch control and the note is out of tune. In this case, use Pitch
Detection.

Next, go back to the Synthesis Looper tool and check Retain Noise.

Finally, specify a Sidelobe Width (%) curve that resembles the one on your
report and press the Do It button. This is a quality control step and should
result in a loop very close to your original sound.

Now the fun begins: Select Retain Noise as desired. Experiment by carefully
adjusting the Sidelobe Width (%) curve to have less width than the original
and press Do It. (Remember to Undo between trails.)

A FINAL NOTE

Remember this: Ensemble sounds vary. When you make a loop you will hear
the variations repeat, over, and over, and over, and over... You can make a
static sound that doesn’t vary (use zero Sidelobe Widths or use Freeze
Looper) but that won't sound like an ensemble. You can’t have it both
ways.

However, this tool lets you determine the trade-off, giving you unprec-
edented control of the of the result.



Appendix A: Keyboard Shortcuts

PRESSING SHIFT+OPTION
WILL TEMPORARILY

PUT INFINITY INTO
SELECTION MODE

PRESSING THE
SPACE BAR
ACTUATES THE
SPEAKER ICON

shift | cntrl

opt. | shift

Ao keys
zcroll data.
<0pt. = tarrow s
for full zoom.

space| 38
bar [++++ #EF
P ®[|®]

SCROLLING DATA

TO:

Scroll Mainview to the right
Scroll Mainview to the left
Scroll Mainview up

Scroll Mainview down

Scroll right by one windowful
Scroll left by one windowful
Scroll up by one windowful
Scroll down by one windowful
Scroll full left and center

Scroll Mainview to the loop start
Scroll Mainview to the loop end
Full zoom to loop start function
Full zoom to loop end function

The keyboard command equivalents listed below
are grouped by function. For instance, commands
that scroll the data in the Mainview are grouped
together. Keys that have names, like Shift, will be
shown as <shift>. Two named keys that are used

together look like <shift-option>.

Pressing on the Palette and using Balloon Help
will show many keyboard shortcuts.

KEY COMMAND:
<right arrow>
<left arrow>

<up arrow>
<down arrow>
<shift-right arrow>
<shift-left arrow>
<shift-up arrow>
<shift-down arrow>
<home>

[

-]

<option> [
<option> ]
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CHANGING DISPLAY SCALING

TO:

Double vertical display resolution

Halve vertical display resolution

Double horizontal display resolution

Halve the horizontal display resolution

Go to minimum vertical display resolution
Go to maximum vertical display resolution
Go to minimum horizontal display resolution
Go to maximum horizontal display resolution
Fit the current selection in the Mainview

Full zoom to the loop start function

Full zoom to the loop end function

FILE COMMANDS

TO:

Create a new soundfile

Open an existing soundfile

Close a window

Save a soundfile (update the backup file)
Get information about a soundfile

Quit Infinity

EDIT COMMANDS

TO:

Cut data from the soundfile into the Clipboard
Copy data into the Clipboard

Paste data from the Clipboard
into the soundfile

Clear data from the soundfile (delete)
Clear Unselected data from the soundfile
Mix

Create or delete loop points

Select the loop data

Select all the data in the soundfile

To drag both loop points simultaneously

KEY COMMAND:

& <up arrow>

¥ <down arrow>

3 <right arrow>

3 <left arrow>
<option-down arrow>
<option-up arrow >
<option-left arrow>
<option-right arrow>
38-F

<option> [

<option> ]

KEY COMMAND:
#-N

¥-0

#-w

¥-S

-1

¥-Q

KEY COMMAND:
*-X
3#-C

¥#-V

38-B or <delete>
¥#-T

3#-M

38-P

38-L

¥#-A

<option> drag



LOOPING TOOLS

TO:

Call the SPR Looper

Call the Rotated Sums Looper
Call the Freeze Looper

Call the Crossfade Looper

PALETTE
TO:

Momentarily put the active window
in Zoom Mode

Momentarily put the active window
in Selection Mode

Play/Stop the active soundfile

Create or delete loop points

Scroll the Mainview to the loop start
Scroll the Mainview to the loop end

Fit the current selection in the Mainview

OTHER

To cancel playback and many processing operations

KEY COMMAND:

-1
%®-2
-3
-4

KEY COMMAND:

<control-shift>

<shift-option>
<space bar>
38-P

¥*-[

-1

38-F

<esc> or $-. (period)
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